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Be Grateful

I am humbled and grateful for this 
opportunity to lead the Paralegal 

Division this year. What an awesome 
opportunity to reach people! I am grateful 
for the nine Presidents who led the charge 
during my years on the Board. I am also 
grateful for all the friends I’ve made along 
the way in this journey with the Division.
 Do you keep a journal? Or are you 
a list-maker? I would encourage you to 
make two lists—one where you write down 
things you are grateful for, and the other 
where you list your ideas about opportuni-
ties to invest yourself in the community. 
Think “pay it forward”. Opportunities are 
all around us. Sometimes, the best antidote 
for feeling down in the dumps is to help 
someone else.
 In May, we observed Memorial Day. 

This is a day set aside to 
remember those who gave 
their lives for this coun-
try. In November, we will 
observe Veterans Day. That 
is the day to honor and give 
thanks to present and for-
mer members of the  
military. 
 Those of you who know 
me very well know I have a 
passion for our veterans. Men in my family 
have been involved in every war this coun-
try has fought, from the Revolutionary War 
right down to the present. Because of their 
service, I owe a debt I can never repay. I 
can’t give them back what they lost. I can’t 
take away the nightmares. But, I can do 
this: I can organize and put on free legal 
clinics for veterans. I can energize para-
legals and attorneys to give back to those 

who have given us so much. 
 What can you do in your own com-
munity, in your own District, to show 
how grateful you are? It doesn’t have to be 
something for veterans. Maybe there’s a 
homeless shelter where you can volunteer, 
just to acknowledge how thankful you are 
to have your own place, your own bed, 

your own kitchen. Volunteer 
to tutor a struggling stu-
dent. Maybe you can be a 
part of the Blanket Brigade 
in San Antonio, a Wills for 
Heroes event in East Texas, 
or the Amarillo Snack Pack. 
Perhaps you could volunteer 
at the local women’s shelter 
or food pantry. There are so 
many ways we can give back. 

If you need ideas on how to volunteer, 
contact your District Director https://txpd.
org/contacts.asp#contact260. My challenge 
to every member is to get involved in 
some way to give someone a hand.

Mona H. Tucker, ACP
2017 President, Paralegal Division, State 
Bar of Texas

P R E S I D E N T ’ S  Message
Mona H. Tucker, ACP

NEW ETHICS CLE REQUIREMENT

 The Paralegal Division’s vision is empowering paralegals; as such the board feels that ethics education is 
important. At the June 22nd meeting, the Board of Directors voted to approve that for all renewing active 

and associate members one (1) hour of the current six (6) CLE hours will need to be in Ethics. This new CLE 
requirement is effective for the 2017–2018 membership renewal period. Upon renewal, all active and associ-
ate members should remember when obtaining your six (6) CLE hours that one (1) of those hours will need 

to be an Ethics CLE obtained by May 31, 2018. 
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E D I T O R ’ S  Note
The Paralegal Division has exciting events coming 

up this fall!  “TAPS Unmasqued—Knowledge 

Awaits 2017” is the theme for this year’s upcoming Texas 

Advanced Paralegal Seminar (“TAPS”). This is the 

Paralegal Division’s annual CLE event that offers up to 14 

hours of CLE. It will be held on October 4–6 in Addison. 

Interesting and informative CLE presentations are sched-

uled and I would encourage you, if you get the chance, to 

attend a presentation you may not normally attend. Take 

advantage of the opportunity to learn about another topic and you might find that it will 

apply to you in your work or even personal life in some way!  There are also several net-

working opportunities, including a murder mystery dinner. Please join us in the murder 

mystery masquerade spirit and wear your masquerade costume.

In this edition, one the TAPS Friday’s speakers, Cameron Vann, of Texas Lawyers’ 

Assistance Program (TLAPP), touches on how paralegals and other non-attorneys 

should look out for signs of stress “displayed by an attorney, as well as themselves. 

Mona Hart Tucker gives her first President’s Message in this edition and there is 

an introduction of the Board of Directors and Committee Chairs. President-Elect, 

Stephanie Sterling, TBLS-BCP, gives a board meeting update, including an impor-

tant new ethics membership requirement. Of course, Ellen Lockwood, Ethics Chair, 

advises about tough ethical issues in her quarterly column. You can find more ethics 

guidelines in the PD’s Paralegal Ethics Handbook available at https://txpd.org/page.

asp?p=Ethics%20Handbook%20Flyer.

Every 12 years, the Texas Legislature has a “Sunset” process and reviews its state agen-

cies’ success and effectiveness in carrying out the responsibilities of state government. 

Professional Development Chair, Donna Lynn Waldon, and District 3 Director, Mary 

Wintermote, provide a summary of this year’s Sunset legislative session. Of course, do 

not miss the recap of the 2017 Annual Meeting and this year’s award recipients!

The Publications Committee is always looking for articles and submissions.  

Please contact us at tpj@txpd.org with your ideas, suggestions, or  

submissions!

Megan Goor, TBLS-BCP, Immediate Past President and TPJ Editor, is 

the Senior Paralegal at The Brender Law Firm, Fort Worth, TX.
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Ten Tips for Paralegals to Recognize Lawyers 
Dealing with Stress, Mental Health, and 
Substance Use Issues
Cameron Vann, JD, MEd, Mediator

Cameron Vann is one of the featured Friday morning speakers at TAPS this year. 
Cameron Vann has been licensed as an attorney since 1982. After graduating from the 

University of Texas with a Bachelor of Science and from the University of Houston with 
a Master of Education, Cameron pursued a teaching and administrative career in Spring 
Branch Independent School District. She then earned her Doctor of Jurisprudence from 
the University of Houston and joined a mid-size civil litigation firm. In 1985 she opened 
her private practice in Houston, focusing on probate and elder law. In 2006 she moved 
to Austin to work at Advocacy, Inc. representing clients with mental health disabilities 
until she joined the TLAP staff in July 2008.

While practicing in Houston, Cameron served on several boards and received awards 
for her work from Baylor College of Medicine, Alzheimer Association, Mental Health 
Association, Association of Women Attorneys, and Rotary. While at Advocacy she served 
on the Mental Health Community Committee and the Jail Diversion Committee. She is 
a past board member of the Travis County Women Lawyers Association.
Ms. Vann’s topic, “This is All About You—Maintaining Wellness in the Legal 
Community,”  is one not to be missed. Here is an excerpt of some of the signs for para-
legals to look for in recognizing lawyers dealing with stress and other issues:

Being in the legal profession, you realize that being a lawyer in Texas is not easy. Here 
is some basic information and tools to help paralegals understand and address the seri-
ous stress, mental health and substance use issues which so many attorneys face.

In Texas, it may be no surprise that lawyers suffer very high rates of mental health 
and substance use disorders. Lawyers are handed their clients’ worst problems and are 
expected to solve them. They are supposed to be perfect or their reputations dwindle. If 
they make a mistake, it can be career changing or devastating to a client’s life. There is 
little time to smell the roses, and when that opportunity comes, it is hard if not impos-
sible to stop thinking about the fires which need putting out at the office. It is a tremen-
dous understatement to say that the life of a lawyer can be very stressful and difficult.

Obviously, these are major problems. No one wants to be troubled by thinking about 
these issues, but they demand real attention. This article is an effort to provide some 
basic information and tools to help paralegals and others in contact the legal community 
understand and address the unique and substantial stress, mental health and substance 
use issues from which so many attorneys suffer. 

When dealing with the spectrum of problems faced by Texas attorneys, there is no 
single solution which will take care of everything, but many tools are useful for both 
mental health and substance abuse issues. The following are ten practical tools which 
paralegals should consider using for prevention or to help solve a problem:

C
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1. Take Action! 
Whether a lawyer is 
living in the dark-
ness of depression 
or lost in a routine 
of substance abuse, 
there is a solution 
but it depends on 
action. Taking action 
requires courage. By 
expressing the need 
for help to someone, 
the process to peace 
begins. TLAP is avail-
able for any lawyer to 
confidentially share a 
desire to change the 
way he or she is liv-
ing and to assist the 
person in getting the 
help needed. Once 
an attorney is able to 
take even the smallest 
action toward solving 
their problem, life 
gets better quickly. 

a. Get Professional Help. 
Lawyers are slow to utilize profes-
sional assistance, perhaps due to fear 
of what people might think, how it 
might affect their practice, or being 
ashamed of not being able to figure 
it out alone. It has been said that 
people cannot think their way out of 
bad thinking. Of all people, lawyers 
know that using a professional who 
specializes in solving a particular 
problem is wise. 

If what you are doing is not 
working and you would like to con-
fidentially get professional help but 
do not already know a suited pro-
fessional, TLAP can help guide you 
to licensed professionals who are a 
good fit for you and who are experi-
enced in working with lawyers. 

b. Take The Steps Which Are 
Suggested.  
Having discovered and accepted 

the fact that a problem exists, it is 
important to accept help from peo-
ple who have experience in solving 
that problem. Once a plan is made, 
it is important to accept and follow 
the steps suggested for getting bet-
ter. Professionals and doctors may 
prescribe certain actions to address 
your problem and which may bring 
about major changes in the way you 
function and feel. Likewise, there 
are many 12 Step programs which 
provide guidance for recovery from 
a variety of problems and which 
suggest specific actions which bring 
about change in the way a person 
thinks and lives so as to overcome 
the “problem.” 
c. Get proactive. Know that this 
profession can wear you out. So, get 
an annual physical. Take a vacation 
(or “stay-cation”). Develop a team 
of experts for yourself: peer support, 
primary care physician, therapist 
and psychiatrist. Act now, do not 
wait to address your burnout, sense 

of dread, linger-
ing grief, daily 
fear, or excessive 
substance use 
intended to numb 
all of the above.

d. Call TLAP. 
The only way to 
ensure that the 
situation changes 
for you is to take 
action. It may 
be hard to figure 
out what action 
to take. If you are 
wondering what 
to do, TLAP’s 
experienced and 
professional 
staff is available 
by phone 24/7 
to answer your 
questions about 
substance abuse, 
mental health 

and wellness issues. Your calls will 
be to attorneys with resources and 
helpful ideas to better your life. 
You can call TLAP at any time at 
1-800-343-TLAP(8527). By statute, 
all communications are confidential 
pursuant to the Texas Health and 
Safety Code Chapter 467. TLAP ser-
vices include confidential support, 
referrals, peer assistance, custom-
ized CLE and education, mandated 
monitoring, and volunteer oppor-
tunities. Without proper interven-
tion and treatment, substance abuse 
and mental illness are both chronic 
health conditions that worsen over 
time. Please call and find out how 
TLAP can help.

2. Set Boundaries. 
Boundaries are important for a person 
practicing self-care. Personal or profession-
al boundaries are the physical, emotional 
and mental limits, guidelines or rules that 
you create to help identify your responsi-

Focus on...
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bilities and actions in a given situation and 
allow you take care of yourself. They also 
help identify actions and behaviors that 
you find unacceptable. They are essential 
ingredients for a healthy self and a healthy 
law practice. In essence, they help define 
relationships between you and everyone 
else. 

How does one establish healthy 
boundaries? Know that you have a right 
to personal and professional boundaries. 
Set clear and decisive limits and let people 
know what you expect and when they 
have crossed the line, acted inappropri-
ately or disrespected you. Likewise, do not 
be afraid to ask for what you want, what 
you need and what actions to take if your 
wishes are not respected. Recognize that 
other’s needs and feelings and demands 
are not more important than your own. 
Putting yourself last is not always the 
best—if you are worn out physically and 
mentally from putting everyone else first, 
you destroy your health and deprive others 
of your active engagement in their lives. 
Practice saying no and yes when appropri-
ate and remain true to your personal and 
professional limits. Do not let others make 
the decisions for you. Healthy boundaries 
allow you to respect your strengths, your 
abilities and your individuality as well as 
those of others. 

3. Connect with Others. 
Connecting with others who know first-
hand what you are going through can 
help reduce the fear and hopelessness 
that is often connected to mental health 
and substance use disorders. A growing 
body of research shows that the need to 
connect socially with others is as basic 
as our need for food, water and shelter. 
Fortunately, there are support groups 
available for lawyers. TLAP and the Texas 
Lawyers Concerned for Lawyers programs 
have joined together to offer and sup-
port lawyer self-help and support groups 
around the state. Groups are active around 
the state in major cities and other areas 
(Austin, Beaumont, Corpus Christi, Dallas, 

El Paso, Ft. Worth, Houston, Lubbock, Rio 
Grande Valley, and San Antonio). These 
groups operate to support lawyers deal-
ing with a variety of concerns, primarily 
stress, anxiety, substance use, addictions, 
and depression. A list of active groups and 
local contacts is available at www.texasbar.
com/TLAP.
Additionally, TLAP’s resources include a 
dedicated and passionate group of hun-
dreds of volunteers who can connect with 
a lawyer suffering from a mental health or 
substance use issue. These volunteers are 
lawyers, judges and law students who are 
committed to providing peer assistance to 
their colleagues and who have experienced 
their own challenges, demonstrated recov-
ery, and are interested in helping others 
in the same way they were helped. TLAP 
volunteers uniquely know how important 
confidentiality is to the lawyer in crisis and 
are trained to help in a variety of ways: 
providing one-on-one peer support and 
assistance, sharing resources for profes-
sional help, introducing others to the 
local support groups and other lawyers in 
recovery, speaking and making presenta-
tions and a host of other activities. 

4. Practice Acceptance. 
Acceptance is a big, meaningful word 
which encompasses a variety of important 
tools for a person seeking a positive life 
change. First, being able to honestly accept 
the place where you are at present is an 
important step in making a change. Until 
a person is able to accept that the future is 
not here yet and that the past is gone, he 
or she cannot be present to focus on what 
is within grasp that day. 

Furthermore, accepting that some-
thing is wrong is a step many lawyers 
resist. Perfectionism and pride play a role 
in learning to be a good lawyer, but the 
effects of those can be limiting on a person 
who needs to get honest about a difficulty. 
Acceptance of the fact that you have an 
issue for which help is needed is a major 
part of solving the problem.

5. Learn to Relax. 
For attorneys, relaxing can seem almost 
impossible. The mind is an instrument, 
but sometimes it seems that the instru-
ment has become the master. Breathing 
exercises, meditation, and mindfulness 
practices have been very effective for 
attorneys who need to relax, or “quiet the 
mind.”  Much has been written to express 
how impactful these tools can be to bring 
about peace in the life of an attorney. 
There are countless variations of breath-
ing exercises and resources to learn how 
to build control of your thoughts and 
worries. TLAP’s website includes links to 
several of these wellness resources at www.
texasbar.com/TLAP.
Suggestion: Calendar what you want to 
do. Wishing and wanting to change are 
important ingredients for change but 
action is important. If there is something 
that you want to do, what would be the 
first thing to accomplish to move toward 
that goal? Calendar it. First things really 
do come first. Try it!

Finally, in order to relax, cultivate 
interests unrelated to the practice of law. 
This will provide you with opportunities 
to take a well-deserved break from your 
work, and, quite frankly, helps to make 
you a far more emotionally well-developed 
and interesting person. You will also meet 
a host of new friends and contacts who 
will help give some additional perspective 
about your life and your choices.

6. Practice Positive Thinking. 
There is a growing body of research show-
ing the powerful positive effects of positive 
thinking and positive psychology. The goal 
of this movement is to help people change 
negative styles of thinking as a way to 
change how they feel. 
Suggestion: Make a Gratitude List. One way 
to practice positive thinking is to focus 
your attention on what is right in your 
life. This is a proven and effective way 
to escape the sometimes overwhelming 
thoughts of all of the things that may seem 
to be wrong. Become conscious of your 
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gratitude. Studies have shown that taking 
the time to make a list of things for which 
you are grateful can result in significant 
improvement in the way you feel and the 
amount of happiness you experience. Try 
making a list of three to five things for 
which you are grateful each morning for a 
week and see what happens.

7. Help Others. 
Service work sounds like just one more 
thing to add to the list of things you do 
not have time for, but this is something 
helpful for you, so consider really making 
time to do. Obviously, until you secure 
your oxygen mask, you should not attempt 
to rescue others, but lawyers have been 
found to gain “intense satisfaction” from 
doing service work,  and studies show it 
helps improve mental health and happi-
ness. 

For example, a researcher named Dr. 
Martin Seligman highlighted this theory in 
an experiment called “Philanthropy versus 
Fun,” Seligman divided up his psychology 
students into two groups. The first partook 
in pleasurable past times such as eating 
delicious food and going to the movies. 
The second group participated in philan-
thropic activities, volunteering in feeding 
the homeless or assisting the physically 
handicapped. What Seligman found was 
that the satisfaction and happiness that 
resulted from volunteering was far more 
lasting than the fleeting reward of food or 
entertainment. Even if you feel that it is 
being done for your own selfish gain, try 
it anyway and before long you will experi-
ence a heightened sense of peace, joy and 
satisfaction in life.
Service Work Suggestions: Try to do some-
thing kind for someone at least once a 
week. Try something small. If you have the 
time, volunteer your time to help another. 
Do not make the activity about you—it 
should be about giving to others. Whatever 
measure you take, large or small, remem-
ber that it will not only help others, but it 
will also serve to build your self-esteem, 
help put your life in perspective, and help 

to develop and maintain a vital connection 
with the community in which you live. 

8. Live in the Present. 
This cliché phrase may be one of the most 
under-appreciated tools for the legal pro-
fession of any listed here. As lawyers, this 
sounds like a joke. Deadlines loom. Trials 
approach. How can this work?

Try it. Consider during your day the 
things which you are able to do that day. 
Live it “only for today.”  If nothing can be 
done about something on your mind in 
the day you are in, return your focus to the 
things you can do that day. If you are not 
happy with your circumstance, what incre-
mental thing can you do today about it?  
Nothing? Then move on and enjoy your 
today. As one attorney put it, “Be where 
your feet are.” The Serenity Prayer is 
something which can serve as a means to 
practice this “one day at a time” method:  
“God, grant me the serenity to accept the 
things I cannot change, The courage to 
change the things I can, And the wisdom 
to know the difference.”  

9. Expand your Spirituality or 
Consciousness. 
Whatever the variety, research has shown 
that expanding this area of life makes a 
major impact of the wellbeing of people, 
and particularly lawyers. Spirituality has 
many definitions, but at its core spiritu-
ality brings context to our lives and the 
struggles within them. For many lawyers 
dealing with the legal world and its many 
issues, expanding the spiritual life is 
invaluable. Other lawyers who do not pre-
fer religion or traditional spiritual prac-
tices often find great benefit to expanding 
their consciousness by means of an expan-
sion of an involvement in natural, philo-
sophical, or other pursuits which bring 
about the contemplation of the reality of 
existence. 

10. Keep it Real. 
Recovering from a mental health or sub-
stance abuse problem requires honesty. If 

you begin to feel like you should be better 
than you are, but you are embarrassed to 
let others down by admitting your true 
condition, you are doing yourself a major 
disservice. Commit to “keeping it real.”  
Be honest with someone about how you 
are doing so that you do not lose touch 
with those who can help. 

One way to develop or ensure honesty 
with ourselves is to do an inventory. We 
all know that any business that fails to take 
inventory is bound to fail. People are no 
different. Assessing your life by taking an 
inventory or snapshot of your daily life can 
give you an idea of where you are and —of 
equal importance—where you want to 
go. Small corrections in allocation of time 
today will help prevent an out-of-balance 
life tomorrow. 

Here is an exercise to help with this 
type of inventory: Draw a circle and divide 
the circle into wedges representing the 
time spent on your daily activities. Are you 
happy with the allocation of time and en-
ergy? Are there areas where you spend the 
majority of your time and you wish you’d 
spend less? Are there areas where you de-
vote minimal or no time but wish you did? 
There is no right or wrong allocation. After 
all, it is your life and your responsibility. If 
your inventory highlights areas of concern, 
what can you do to change them? Or, 
better said, what would your perfect day’s 
circle look like? Would there be enough 
time for all-important life activities: work, 
family, self, exercise, friends, hobbies, 
spiritual practices, meditation, fun, sex and 
sleep? What’s really important to you? 

Cameron 
Vann, Senior 
Staff Attorney, 
Texas Lawyers’ 
Assistance 
Program. www.
tlaphelps.org
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Paralegal Use of Technology in the Office and on the Run!
By Michelle Spencer, Ernesto Gonzalez, and Brandon Turnage

I. Introduction

Paralegals need many technology tools to keep up with the busy attorneys they support 
and provide exemplary customer service to their clients. In family law, this can include 
pulling together financial documents, assisting with items to be produced in discovery, 
and preparing evidence for trial. The documents paralegals work with can be anything 
from text messages to photos to complex financial spreadsheets or even discovery logs in 
Excel. Given the mobile nature of client data, there are more places and types of infor-
mation to be handled. Our goal is to acquaint you with some tools and techniques that 
will aid in making your job as a paralegal easier.

II. PDF Acrobatics

A. Adobe Acrobat vs. Other Products
In addition, Acrobat offers tools for capturing websites and creating PDF portfo-
lios from Outlook PST files, which are great tools to have when you need them. 
With the proliferation of electronic data being handled in most family law cases, 
you do not have to break the bank, but you do need a fully capable tool for work-
ing with PDF files.

All of the PDF file manipulation platforms described below have been used by 
numerous law firms for years and would suit the basic needs of any law office. For 
specific features, like redaction and Bates numbering, be sure to confirm that the 
level of software you are purchasing has those features you need in your practice. 
Another key differentiator is whether the platform will integrate with your docu-
ment management system. If that is something you will need, be sure to confirm 
exactly how it works prior to purchasing a solution. Most will allow you to do a 
free trial, so try out a couple and decide which works best for you.

1. Adobe Acrobat
Coming from the company that created the PDF file format, Adobe Acrobat is the gold 
standard for PDF file manipulation. Therefore, it has traditionally been priced as such. 
However, the latest version offers a monthly subscription model, so you will receive any 
new updates to the application, and it is a lower initial outlay of cash. In the current DC 
version, several new features have been added. One handy new feature is the ability to 
sign documents electronically with any touch-screen computer. This has really saved 
me when I’ve been mobile and without access to a scanner. Several specific features in 
Adobe Acrobat that are useful for legal consumers are detailed in the sections below.

Licensing
Adobe Acrobat Pro is currently $14.99 per month with an annual commitment. 

P
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Adobe Acrobat Standard is currently 
$12.99 per month with an annual com-
mitment. 

For legal professionals, Acrobat Pro is 
generally needed, because it has the 
tools for doing Bates numbering and 
redaction.

The two sites below will help you decide 
which version of Adobe is appropriate for 
you and your team.

Acrobat Buying Programs Comparison: 
http://www.adobe.com/howtobuy/
buying-programs/compare.html
Acrobat Features: https://acrobat.adobe.
com/us/en/acrobat/capabilities.html 

2. Nuance PowerPDF 
http://www.nuance.com/for-business/
imaging-solutions/document-conversion/
power-pdf-converter/index.htm 

Licensing
PowerPDF Standard 2 - $99 (free trial: 
http://www.nuance.com/for-business/
imaging-solutions/document-conver-
sion/power-pdf-converter/standard-
free-trial/index.htm)
PowerPDF Advanced 2 - $149 (free trial 
http://www.nuance.com/for-business/
imaging-solutions/document-conver-
sion/power-pdf-converter/free-trial/
index.htm)
Volume discounts: 11+ users—contact 
sales for pricing

Features
Redaction (Advanced)
Bates stamping (Advanced)
DMS integration (Advanced)
Automate PDF creation using a 
watched folder (Advanced)
Save a webpage with hyperlinks pre-
served (Advanced)
Proofread and correct spelling errors 
from scanned documents (Advanced)
Office integration
Compare PDFs

3. pdfDocs (www.docscorp.com/trial)
Licensing

Annual subscription; but will sell a per-
petual license; up to 20 licenses
Standard $69
Pro $107 (DMS integration)
Enterprise (Binder features)

Features
Create, edit, and convert image-based 
PDFs
Create and very PDF/A documents (for 
e-filing)
Integration with MS Office and 
DMS (iManage, OpenText, NetDocs, 
Worldox, ProLaw)
Interface similar to Microsoft Office
Organizer workspace for assembling 
files
(Only available in Enterprise version) 
Binder to convert documents into a 
single or multiple PDF documents and 
automatically generate a TOC, hyper-
links and bookmarks. Easily insert 
cover pages, headers and footers.

4. Nitro Pro 10 (https://www.gonitro.com/
pro)

Licensing
1–10 Users $159.99 each
11+ licenses $1583.89

Features
Convert and combine files into PDF 
files
Convert PDF files to Word, Excel and 
PowerPoint
Transform a scanned document or 
image into an editable PDF
Markup PDF files
Electronic signature, collaboration 
tools, and encryption
Bates numbering
Redaction using Electronic Signature 
software
Outlook plug-in—easily convert 
emails, attachments, and entire mail 
folders

B. PDF/A and File Size Requirements for 
Electronic Filing
Not all PDF files are created equally and 

it pays to know what you are dealing with 
due to court requirements for electronic 
filing. Many courts require that documents 
be in PDF/A format to be filed electroni-
cally. The reasons for this requirement 
are that PDF files must be (1) simple (no 
security, multimedia content, or encryp-
tion) and (2) text-based to be accessible 
for screen readers. It pays to understand 
what output you are generally getting from 
the different ways to create PDF files that 
we have in our law offices.

1. Microsoft Office and Scanner PDF 
Conversion Features
Several recent versions of Microsoft Office 
have included the option to save files 
in Adobe PDF format. When installing 
Adobe Acrobat, you have an Adobe PDF 
printer available as well. Some scanners are 
able to create PDF/A-1B files, but most will 
create image-based PDF files, which will 
not work for electronic filing. Therefore, 
it is best to utilize other methods to create 
PDF files when possible.

Save As—PDF/A 1-A—no security, 
encryption, multimedia, attachments
Scanners—PDF/A 1-B –tagging, acces-
sibility, and searchable Unicode text are 
optional

2. Print to PDF Features
When using the print to PDF function, 
click the Printer Properties link (shown in 
the screenshot above) to access additional 
options for formatting the PDF output. 
Those options are shown in the screenshot 
below. You should be aware of the  
following:

Note that one of the options is for 
Smallest File Size. This can be helpful 
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when fi ling documents with courts 
as they generally have fi le size limits. 
However, review your document prior 
to fi ling to ensure content fi delity as 
the DPI or dots per inch are reduced 
from 2400 to 600.
Also, note that there is an Adobe PDF 
Security drop-down for times when you 
need to protect content within a PDF 
fi le. However, security means that a 
document will not be PDF/A compli-
ant. 
There is also a check box regarding 
fonts. Embedding fonts is required for 
PDF/A format. If you have ever seen 
a document where the fonts looked 
strange, it was probably because the 
fonts were not embedded when it was 
created. Hover over any of the check 
boxes to get an explanation of their 
functions.

3. Acrobat Ribbon Options
When you install Adobe Acrobat, the 
Acrobat ribbon is made available within 
Microsoft Offi ce and some other applica-
tions. If you want to see very granular 
details on what the default settings in the 
Printer Properties  (shown above) are, 
you can use the Preferences button on the 
Acrobat ribbon. For instance, in Microsoft 
Word, there are Word and Bookmarks tabs 
to designate how footnotes, comments and 
bookmark linking will be handled.

C. Bates Numbering and Discovery Log
Adobe Acrobat (Pro version) can add 
Bates numbering and generate a discovery 
log for you automatically using the built-in 
Bates Numbering tool. The key to using 
this feature effi ciently is to have a consis-

tent numbering process for naming your 
fi les. Whether you are Bates-Stamping 
2,000 pages or 20,000, this feature is 
invaluable.
 Instructions below are for a prior ver-
sion. For Acrobat DC instructions, click 
here.
1. Click Tools > Pages.
2. Bate Numbering > Add Bates 

Numbering.
3. Select Add Folders (instead of indi-

vidual fi les).

4. Highlight the directory where the fi les 
located and then click OK.

5. Click Output Option.
6. Check Create log fi le and then click the 

Change log fi le location button and 
select your Desktop.

7. Click OK.
8. Click into the desired location: Left 

Footer Text, Center Footer Text, or 
Right Footer Text and then click Insert 
Bates Number.

9. Enter the Bate numbering options: 
Number of Digits, Start Number, 
Prefi x, and Suffi x.

10. Click OK.
11. Click OK.

Poof!  Your documents have been Bates 
numbered and your discovery document 
log has been created. Go to your Desktop 
and look for the Notepad icon titled 
“Bates.” This is the discovery document 
log you created.

In this example, I was using documents 
that were only one page each. In real life, 
your documents (bank statements, credit 
card statements, partnership agreements, 
etc.) will have several pages. The Bates 
numbering feature calcuates the number 
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of pages in each fi le and sends that data 
to the log fi le automatically. This feature 
alone is worth the price of the Pro version 
of Adobe Acrobat. See results below:

D. Redaction
When producing documents contain-
ing sensitive data, it becomes necessary 
to redact such data before producing the 
documents to opposing counsel. The best 
and easiest way to do this is using Adobe 
Acrobat Pro’s redaction feature. Redaction 
is a two-step process. You will mark your 
redactions and then apply them. First, save 
your documents as PDF fi les, and then fol-
low the steps below:
1. Click Tools and expand the Protection 

group.
2. Click Redaction Properties.
3. Click Redacted Area Fill Color and set 

to black.
4. Click OK.
5. Click Mark for Redaction and, using 

your mouse, highlight the sensitive 
data.

Repeat this step for each additional 
area of redaction.

6. When you fi nish marking all areas to 
redact, click Apply Redaction.
WARNING: After they are applied, 

redactions cannot be undone.

E. Email Portfolio
Did you know that Adobe Acrobat can 
create a single PDF portfolio contain-
ing all of the emails and attachments 
in an Outlook PST fi le? You can also 
select messages or folders. This can be a 
handy feature for reviewing or producing 
emails in litigation, as well as archiving 
your own emails after a case has ended. 
It also includes fi lters and the ability to 
add a fi eld in order to designate Key or 
Privileged documents. This function has 
been part of the PDFMaker since Acrobat 

9 and is accessed via the Adobe PDF rib-
bon in Outlook. It also works for Lotus 
Notes. Detailed instructions on the vari-
ous options for creating email portfolios 
are found in the PDF Email Portfolio 
Resources section below.

A sample email Portfolio is shown 
below. The emails are listed in the top sec-
tion with the content of the selected email 
displayed in the bottom section. Click the 
attachment hyperlink in any email mes-
sage or the paperclip to the left to access 
attachments.

Choose either the Folder view or fl at-
tened List view (default) using the two 
buttons at the top of the list. Use the blue 
fi lter icon in upper left to search through 
emails. Filter by fi eld, e.g. To, From, CC, 
Subject to fi nd what you need. The port-
folio includes a full text index of the con-
tents of the emails.

1. How To: Add a fi eld to designate Key or 
Privileged Documents

Modify > Edit Portfolio to go into edit 
mode.
Specify the File Details section.
Name the column Key or Privileged 
and select the type, e.g. Text, Number 
or Date.
Change the column order using the 
arrow keys, if desired.
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Modify > Edit Portfolio to turn off edit 
mode.
Switch to List View to enter text in your 
newly created fi eld.
Update the full text index after add-
ing additional fi elds to avoid slowness: 
Advanced > Document Processing > 
Manage Embedded Index.

2. PDF Email Portfolio Resources
Creating Email Portfolios for Small 
EDD Productions http://blogs.adobe.
com/acrolaw/2009/11/creating-email-
portfolios-for-small-edd-productions/ 
How to convert Outlook email to PDF 
using Acrobat X (video) - https://acro-
batusers.com/tutorials/how-convert-
outlook-email-pdf 
Batch Printing an Email Portfolio 
http://blogs.adobe.com/acrolaw/2011/11/
batch-printing-an-email-portfolio/ 
Case Analysis using PDF Portfolios: 
Part I http://blogs.adobe.com/acro-
law/2008/10/pdf_portfolios_for_case_
analysis/ 
Case Analysis using PDF Portfolios: 
Part II http://blogs.adobe.com/acro-
law/2008/12/pdf_portfolios_for_case_
analysis_1/ 
Case Analysis Part III: Exporting a PDF 
Portfolio List to a Spreadsheet http://
blogs.adobe.com/acrolaw/2008/12/
case_analysis_part_iii_exporting/ 

3. Evermap AutoPorfolio Plug-In
There are some things that Adobe’s 

built-in function cannot do. If this is 
something that you will be using often, 
you may wish to consider the Evermap 
AutoPortfolio Plug-In. Details on its capa-
bilities and pricing are below.

Pricing: $199 or $799/5 users 
or $1699/site license

http://evermap.com/auto-
portfolio.asp 

Flatten all individual mes-
sages and attachments into a 
single PDF document

Extract attachments or con-
vert attachments to PDF

Create TIFF/TEXT combos 
or load fi les for litigation support sys-
tems
De-duping

F. Signature Options in Acrobat DC
No more printing out PDF forms just so 
you can sign, initial or fi ll in a date! Within 
Acrobat DC, click Tools > Fill & Sign. As 
shown below, there are tools for adding 
text or a simple X, checkmark, or circle to 
a PDF fi le. As soon as you click an option, 
you may place the mark in the PDF fi le.

To create your signature, click Sign > 
Add signature and then draw your signa-
ture on-screen. It will be saved for future 
use. If you do not have a touch-enabled 
laptop, see links below for other options 
for creating your signature. Acrobat also 
provides a second signature that can be 
used for either your initials or for hand-
writing a date. 

After saving your signature, to add it to 
a document, you simply click it and then 
position it in the PDF fi le. You will receive 
a warning that you will not be able to 
make changes to the fi le after saving it, so 
be sure that you complete any edits prior 
to signing and saving the fi le.

To change either your signature or ini-
tials after you set them up, simply click the 
minus button to delete it and then create 
a new one.

For more details on using the signature 

feature in Adobe Acrobat, see:
https://helpx.adobe.com/acrobat/using/
capture-and-sync-your-signature.html 
https://helpx.adobe.com/acrobat/11/
using/signing-pdfs.html 
Adobe has a signature service called 
Adobe Sign: https://acrobat.adobe.com/
us/en/sign.html 

G. Acrobat Resources for Lawyers
Acrobat for Legal Professionals Blog—
http://blogs.adobe.com/acrolaw
Litigation Support Guru Fast Tips - 
http://litigationsupportguru.com/
Bates Numbering How-to in Acrobat: 
https://helpx.adobe.com/acrobat/using/
add-headers-footers-pdfs.html
Redaction How-To in Acrobat: https://
helpx.adobe.com/acrobat/using/remov-
ing-sensitive-content-pdfs.html

III. Excelling with Microsoft Excel

A. Discovery Log
Some attorneys require that Discovery 
Logs be prepared in Excel. There are many 
benefi ts to using Excel for that purpose. 
One of the benefi ts is that you can fi lter 
your data to extract relevant data quickly. 
The Filter function in Excel is highlighted 
below.

1. Filtering an Excel Discovery Log
Below is a sample discovery log in Excel 

format (“OR” = Original Response, “1st” = 
1st Supplemental, etc.).

Suppose you want to see all credit card 
statements and bank statements produced 
for 2013. You can quickly fi lter to see just 
that data as follows:
1. On the Data tab, click Filter.

(note that as soon as you click Filter, 
drop-down menus appear on the bot-
tom right of all cells in the fi rst row.

2. Click the drop-down menu for the 
Date Range Start column.



14 texas  paralegal  journal fall  2017

Focus on...

3. Deselect all boxes except 2013.
4. Click the drop-down menu for the 

Identifi er column and deselect Taxes.
The resulting view now shows all credit 

card and bank statements produced for 
2013. Note that the two columns display a 
fi lter symbol next to the drop-down arrow 
for the two columns that are fi ltered.

Notice the blue numbers on the left? 
Those indicate the original line number 
where the data is saved. Before you do 
another search, you will want to click the 
Clear option on the Data tab.

You can use these same functions to 
fi lter text, numbers, dates and times, cell 
colors, etc.

2. Filtering a PDF Discovery Log
What if you receive a Discovery Log in 
PDF format and want to use Excel to fi lter 
the data? How do you do that? First, open 
the PDF document and use Save As. Select 

Excel Workbook (*.xlsx) as the Save as 
Type.

In Excel, highlight all the data and 
choose Format as Table on the Home 
ribbon.

You now have all the data in a fully 
functioning Excel workbook. Use the steps 
above to Filter your data.

IV. A Picture is Worth 1,000 Words

A. Microsoft Windows Built-In Tools

1. Windows Snipping Tool
Do you have an error message that you 
need to send to your IT department? 
Snip it!
Do you have a photo that you need to 
crop? Snip it!
Did you fi nd an online news article 
about a client that you want to save? 
Snip it!

The Snipping Tool is one of Microsoft’s 
best kept secrets and really easy to use. It is 
built into Windows 7 and 10, so no instal-
lation is needed. The Snipping Tool is the 
easiest way to make a copy of something 
on your computer screen. Simply take 
a screenshot using the Snipping Tool to 
share or save. This is what Snipping Tool 
was designed to do.

With the Snipping Tool, you can 
capture part of or your entire computer 
screen. When there is something on your 
monitor that you need to capture, open 
the Snipping Tool. Snipping Tool is gener-
ally already located in your Windows Start 
Menu. If it is not, enter “Snipping Tool” in 
the search box of the Windows Start Menu 
(or Cortana in Windows 10), and click to 
open. To keep the Snipping Tool easily 
accessible at all times, right-click and select 
Pin to taskbar.

After you open the Snipping Tool, you 
have four options located in the drop-
down menu of the New button to capture 
your snip:

Free-form Snip. This option allows 
you to draw a free-form shape around an 
object for those “not so square” shapes 
that you want to snip.

Rectangular Snip. This option allows 
you to drag the cursor to crop a snip in 
the form of a square or a rectangle.

Window Snip. This option allows you 
to select an open application window.

Full-screen Snip. This option allows 
you to snip the entire contents of the com-
puter screen.

After you snip the content that you 
want, you have several options for your 
snip, including:

Writing, drawing, or highlighting on 
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or around the snip using the Pen and 
Highlighter buttons.

Saving the snip to a directory using the 
Save As box.

Emailing the snip using the Email but-
ton.

2. Windows 10 Photo Editor
Many have described the built-in photo 
editor in Windows 10 as a light version of 
Photoshop, which means a savings of sev-
eral hundred dollars. When using photos 
in court, you want to ensure that they are 
as legible as possible, so before you spend 
money on a more expensive and compli-
cated tool, give Windows Photo a spin. 
An added bonus is that you can easily link 
your photo storage to a OneDrive personal 
or business account, and it will even create 
albums for you automatically and ensure 
your photos are backed up to the cloud for 
safekeeping.

B. Snagit (https://www.techsmith.com/
snagit.html)
By far the best $50.00 you will ever spend 
on software you will use every day. Cut 
and paste anything on your screen into 
Word, Excel, Outlook, and many other 
programs.

As Snagit’s creators Techsmith say: 
“Snagit’s image and video capture is pow-
erful, but not complex. You’re in control 
of everything you capture, right down to 
the pixel. All-in-One-Capture® grabs your 

entire desktop, a region, a window, or a 
scrolling window from any webpage or 
application—all with a single hotkey or 
click.”

C. Irfanview (http://www.
irfanview.com/)
If you don’t need something 
as robust as Snagit, but still 
need to grab screenshots or 

edit photos, a great option is Irfanview, 
which is a free tool created by a Bosnian 
guy named Irfan. The beauty of Irfanview 
is that it can be as simple or as complex an 
image editor as you need. I keep it on my 
taskbar for quick access. People always ask 
me what that red icon is.

1. Using Irfanview for Screen Captures
I use this technique all the time to capture 
charts from webinars that I’m viewing, 
screenshots for training, or icons that I 
have created using fi gures in PowerPoint. 
If you can display it on your screen, then 
you can capture it.

To capture your entire screen, press 
the PrtScr key or use ALT+PrtScr to 
capture a single window. These are the 
built-in Windows commands, which 
place the screen capture in your clip-

board.
Next, open Irfanview and paste your 
image there using CTRL+V.
With your screen capture in Irfanview, 
it can be edited or saved in a variety of 
different image formats.
If you only want to use part of the 
image that you have captured, click and 
drag a border around it, then cut that 
portion out using CTRL+X and either 
paste it into Irfanview to save as an 
image or paste it into another program, 
such as PowerPoint or Word.

If you want to get fancier, Irfanview 
also has a built-in capture function that 
even includes a delay timer. Simply select 
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Options > Capture/Screenshot… to see all 
the options available for capturing infor-
mation on your screen.

2. Resize/Resample an Image
Simply open an image fi le and select 

Image > Resize/Resample to see the pleth-
ora of options displayed below. You can 
easily set specifi c sizes or resize as a per-
centage of the original size. Because of the 
fi lters used, you will end up with quality 
images. After you’ve made your selections, 
click OK to save your changes.

3. Add Text to an Image
With Irfanview, you can easily add text 

to an image. Simply click Edit > Insert 
Text or Insert Watermark/Overlay Image. 
Select the font, color, size and location and 
then click OK.

4. Other Image Editing Functions
Under the Image menu in Irfanview, 

there are numerous options for tweaking 
images. There are options to fl ip or rotate 
images. There are several options for 
recoloring or adjusting coloration, as well 

as Sharpen and 
Red Eye Reduction 
tools that work 
very well. Try them 
out. If you do not 
like a change you 
have made, you 
can always simply 
Undo using the 
button on the tool-
bar.

5. Batch Conversion 
or Rename

If you have ever 
needed to rename 
a batch of images, 
Irfanview has a solution for that too. 
Simply follow the steps below to rename 
the fi les. The conversion process works 
similarly.

Need a list of the image fi les? There 
is also a Save as TXT button in the area 
where the fi les are listed that can be used 
to output a list of the fi les into a text fi le.
1. In Irfanview, click File > Batch 

Conversion/Rename.
2. Select Batch rename.
3. Select the folder where the images are 

located
4. Click the Add all button load all images 

and adjust as needed.
5. Set the pattern for the new name.

If you want 3 digits in the new 
name, you must enter “#” three 
times in the pattern. For example: 
Pattern image_### with start index 
1 will produce fi le names image_001, 
image_002, etc.
Use Options for additional settings 
for replacing specifi c strings of text 
in the fi le name, starting number, 
copy vs. move, etc.

6. Set the Output directory for the 
renamed fi les.

7. Click Start Batch or Run test rename to 
test fi rst.

V. On the Run!

A. Ernie’s Courtroom Technology 
Checklist

1. Let the Judge know your game plan prior 
to trial

Ask the Court for the dos and don’ts 
and preferences in his/her court-
room.
Ask the Judge if there is anything 
you can do to make the court’s job 
less stressful when using technology 
in his/her courtroom.
If you are not comfortable with 
using technology in the courtroom, 
hire someone with experience to 
assist you.

2. Batteries, Extra Cables, Toner
Bring extra batteries for remote con-
trols, mice, portable recorders, etc.
Take batteries out of each device 
when packing up to avoid draining 
them when transporting.
Bring extra HDMI, VGA, Printer, 
AC, Display Port to HDMI adapters 
and related cables.
Bring extra toner and paper for the 
printer.

3. Text Messages and Emails
Make each text message and/or 
email thread a separate exhibit.

Focus on...
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Refer to Bates stamp numbers on 
each page for easier identifi cation.

4. Courtroom Lighting (mainly for jury tri-
als)

Become familiar with the courtroom 
lights (gallery, jury box, screen, etc.).
Ask permission to label the light 
switches for the Judge.

5. Internet Access
Bring your own mobile hotspot.
Do not rely on Internet service pro-
vided by the county as some web-
sites may be blocked.
Have a backup (know how to use 
your cell phone as a hotspot).

6. Schedule a Practice Run in the 
Courtroom

Coordinate a convenient time with 
the Court Coordinator and other 
court staff.
Practice using the court’s equipment 
(left laptop, right laptop, and cart).
Report courtroom equipment prob-
lems as soon as possible to avoid 
delay in repairs.
Bring and test ALL your equipment 
in the courtroom, including your 
backup laptop and iPad.
Coordinate your visit with your 
opposing counsel’s tech person 
to avoid technical issues they may 
encounter during trial.
See Courtroom Technology 
Checklist (see Appendix A hereto).

7. Playing Audio/Video Files
Timestamp all video you intend to 
use for faster cuing.
Play and listen to all audio and 
video clips using the same equip-
ment you intend to use at trial.
Be aware of the different audio/
video formats available and confi rm 
compatibility with DVD play pro-
vided in the courtroom.
Suggested video editing software: 
Windows Live Movie Maker or 

iMovie. For more advanced features, 
try Adobe Premier or Apple Cut 
Pro.

8. Have “Plan B” Ready
HD TV (at least 50-inch with HDMI 
inputs)
DVD player (not the one in your 
laptop)
Portable high quality Bluetooth 
speakers
20x30 size paper and easel
Paper copies of all exhibits

9. Test Your Equipment with Courtroom 
Equipment

VGA (with audio cable)
HDMI
Document Camera (ELMO)
DVD player

10. Test Your Equipment in Your Offi ce. 
Then, Test it again!

Laptop (main and backup)
iPad (main and backup)
Printer
Scanner
Keyboard and Mouse (USB combo 
okay; backup should be hard wired) 

B. Brandon’s Trial Tips for Low Tech 
Jurisdictions

Three letters:  U—S—B.
Yes, it’s a paper trial, which generally 

means that you are lugging around 5 sets 
of binders full of paper copies of all your 
trial exhibits. Even so, it is a good idea to 
have an electronic copy of your client’s 
directory which contains all the docu-
ments that you have scanned into that 
directory.

It is also a good idea to set up a cloud 
service (i.e. Dropbox, OneDrive, or Box) 

and upload a duplicate of the USB drive to 
the cloud, so that you have online access to 
your fi le in the event that your computer 
and the USB drive don’t get along or you 
lose all of the USB drives that you made. 
(You are encrypting your USB drives, so 
your client’s data isn’t wide open to any-
one, aren’t you?)

It is also a good investment to purchase 
a small printer that you can carry with 
you to print any last-minute exhibits that 
you were sure you would not need. Make 
sure the drivers for the printer are loaded 
on any laptops you will be using BEFORE 
you leave the offi ce or that you can directly 
connect the USB drive to the printer. Test 
everything before leaving the offi ce. Be 
sure to pack paper and toner or inkjet car-
tridges in your courthouse kit.

C. Text Message Download Apps

1. TunesGo (Mobilego for iOS) by 
Wondershare (http://tunesgo.wondershare.
net/buy/buy-tunesgo-ios.html?f=pro)
This software allows you to download all 
Contacts, SMS, Photos, Videos, and Music 
from any iOS device. There is also a ver-
sion for Androids.

Often in discovery you need to produce 
SMS (text messages). One of the features 
this software has is the ability to download 
SMS messages and then export them to an 
Excel fi le for review. See sample snapshot 
below:

It is also a quick and effi cient way 
to download photos from your client’s 
phone, if relevant, to produce in discovery. 
You can even download video!

The costs in $49.00 for lifetime license 
or $39.00 for 1 year. 

2. iExplorer (https://www.macroplant.com/)

Focus on...
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Most family law cases deal with text 
message correspondence between the par-
ties. We are usually lucky to get a group of 
messages that our client has taken screen-
shots, which leave our minds reeling with 
the task of piecing the messages together 
in an order so that someone else can get 
the gist of the conversation. With access 
to the device, it’s a snap to grab what you 
need in a manageable format.

iExplorer is software by Macroplant 
that allows fi le transfer from iPhone, iPad 
and iPod. The basic software package runs 
$39.99 for one license and $59.99 for fi ve 
licenses.

iExplorer works in concert with iTunes, 
so you must also have the iTunes software 
installed on your PC or Mac.

Simply connect the mobile device to 
a computer or laptop using a USB cable. 
iExplorer will create a back-up fi le for 
the device’s content from which you can 
export the SMS messages. To access the 
SMS messages, click on the Messages tab 
in iExplorer. iExplorer will take you to a 
window that has all SMS message conver-
sations on the device. Pick the text mes-
sage conversation that you want to export, 
and simply export the entire conversation. 
iExplorer gives you options for fi le types 
to export the conversation: CSV, TXT, or 
PDF. You can fi lter & export images, vid-
eos, vCards, and other attachments from 
text message conversations. iExplorer also 
allows you to fi lter text messages by date 

range. Exporting to .CSV format can be 
helpful with large amounts of data, so you 
can use Excel’s sorting and fi ltering func-
tions.

WARNING: This software can access 
the fi les on the mobile device without hav-
ing the password for the device, so be very 
careful with its use in your practice.

You can also export call history, music, 
photos, and recordings with iExplorer.

Appendix A
Courtroom Technology Checklist

repairs needed can be noted, so you can 
share this with courtroom staff.

Michelle Spencer, Founder, Legal 
Learning Development Network, Austin, 
Texas. www.LegalLearningNetwork.com

Ernesto A. Gonzalez, Board Certifi ed 
Paralegal, Family Law Mediator, E.A. 
Gonzalez Consulting, Katy, Texas. Www.
Eagonzalez.Com

Brandon Turnage, Paralegal, Koons 
Fuller, Southlake, Texas. www.koonsfuller.
com
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Brief Writing: Make Yourself Useful as Well as Ornamental1  

By Steven K. Hayes and Brittani Wilmore Rollen, with suggestions from Justice Sue Walker, Dabney Bassel, and Constance K. Hall. A 
slightly different version of this article was previously published in the Litigation Section’s Fall 2016 issue of The Advocate (76 THE ADVOCATE 
27, Fall 2016 (State Bar of Texas Litigation Section)) and in the Summer 2017 issue of The College News, published by the Texas College 
Bar.

Your appellate brief should argue your client’s position to the court of appeals2 in a way 
the court finds useful, as well as persuasive. Your facts should be so accurate, persuasive, 
and well sourced, and your legal analysis so persuasive and supported by such good 
authority, that the court can copy and paste entire portions of your brief into its opinion. 
The following suggestions will help you accomplish that.

Include all the items required by TRAP 38.
TRAP 38.1 lists the items your brief must include, and the order in which they should 

appear. Use them to construct the template for your brief before drafting anything sub-
stantive.

Know your audience.
Your audience is typically a three-judge panel and their staff attorneys. These folks usually 
had significant experience in a law practice, and have significant experience handling an 
appellate docket. They face a never-ending avalanche of cases.3 Time is the enemy,4 with 
each justice’s office issuing the equivalent of a term paper a week. The courts of appeals 
were surveyed in 2009, and half the justices felt that most briefs were too long; a 2012 
Survey of the justices revealed the same sentiment.5 These dynamics mean that you need 
to shorten, clarify, and simplify your brief. 

Y
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Write in the active voice.
To make it as easy as possible for the court 
to follow your argument and rule for 
your client, write in the active voice. This 
shortens your brief and makes it more 
persuasive.

Write for your audience, not for yourself.
Write for the court, not for yourself. You 
already believe your case—you need to 
make experienced jurists, who do not care 
which side wins, believe it as well. So get 
a second set of eyes to mercilessly critique 
your argument. Also have them critique 
your grammar, style, content and especial-
ly the “appropriate citations to authorities 
and the record” required by TRAP 38(i). 
The court will mercilessly examine your 
citations to the record and authority, and 
you will lose credibility if you miscite 
either.

Do not just tell your story in the Facts 
and Argument—tell it in the Issues, the 
Table of Contents, and the Summary of the 
Argument.

Your brief, working as an integrated 
whole, should tell your story in each of 
these five TRAP 38 requirements: the Table 
of Contents; the Issues Presented; the 
Statement of Facts; the Summary of the 
Argument; and the Argument. Here’s how.

Use headings and subheadings to 
divide your Statement of Facts and your 
Argument. Those visually divide the brief 
into bite-sized portions for the court, and 
help you ensure the logical progression of 
your brief. As more than half the Justices 
recommend, each major heading in your 
brief should either consist of an Issue, or 
expressly say which Issue(s) it deals with, 
so that your Issues and Argument dove-
tail.6

In addition to reinforcing the Issues 
and making the brief manageable, those 
headings and subheadings will populate 
the Table of Contents with your central 
facts and arguments. Seventy percent of 
justices find the Table of Contents helpful, 
and another twenty-five percent emphasize 
that it should repeat headings from the 

Statement of Facts and Argument.7 You can 
then draw your Summary of the Argument 
from the Table of Contents. No matter 
where the Justices go first in your brief, 
they see your story repeated.

You should also bookmark the headings 
and subheadings in the pdf of your brief, 
allowing the court to go straight to a par-
ticular issue or argument (a useful tool you 
can enhance by appropriately hyperlinking 
sections of your brief to each other).8  

Also, don’t overlook the importance 
of the standard of review, on which you 
should build your argument. If the court 
can decide an issue as a matter of law—
such as duty or causation—it has much 
more leeway than an abuse of discretion 
standard provides.

Make all your Issues indisputable state-
ments—and limit their number.

More than ninety percent of justices 
expect a wise advocate to present them 
with five or fewer issues in an appeal of 
moderate complexity—and around half of 
those justices feel that four or fewer issues 
is appropriate.9 Over seventy percent of 
justices prefer the issues be presented as 
positive statements-you might even con-
sider stating them as “The trial court erred 
[or abused its discretion] in . . . .”10 To the 
extent possible, make your Issues indisput-
able, and succinct. Ideally, they should be 
easily embraced talking points.

Remove yourself from the dispute.
If you tried the case, it may be difficult to 
write a succinct Statement of Facts. You 
may find it helpful to write the Argument 
first. You can then populate your State-
ment of Facts with facts important to your 
Argument.

End with a Conclusion, and then a Prayer 
which gives the Court a roadmap.
Nearly sixty percent of justices preferred 
the brief end with a conclusion and a 
prayer.11 One justice requested that at-
torneys “state in your prayer the exact 
judgment you seek,”12 a sentiment we have 
heard expressed by many justices.

Even though you e-file, keep your Ap-
pendix as short as possible. 

TRAP 38.1(k)(1) tells you what items 
must be in your Appendix, and 38.1(k)
(2) tells you what can be in your Appen-
dix. Even with e-filing, keep your Ap-
pendix as short as the rules allow. A pdf 
brief containing 200+ pages of Appendix 
unnecessarily sends the wrong message. 
If only a few sentences or words of the 
contract/document governs, put just those 
in your Appendix—not the whole docu-
ment. Many, if not most, justices use two 
computer screens, one open to the brief, 
the other open to the record and Westlaw/
Lexis. It is less distracting for the Justices 
to use your brief citations to search the 
record or Westlaw/Lexis on another screen 
than to jump down and up from brief to 
Appendix. Furthermore, automatic hyper-
linking to Texas and Fifth Circuit author-
ity created by the e-filing portal means 
you do not need to attach copies of Texas 
or Fifth Circuit cases or Texas or federal 
statutes. You can, and should, highlight the 
important words in cases and statutes by 
quoting them in your brief, which has the 
happy coincidence of underscoring your 
argument.  

Having said that, a succinctly done 
Appendix can really help the Court. You 
cannot use it “to attempt to avoid the page 
[now word] limits of the brief” (TRAP 
38.1(k)(2)) nor to sneak in facts not in the 
record, but you can use it for timelines 
which track your story, or diagrams which 
guide the court through the issues (i.e., if 
you rule against Appellant on X, you do 
not need to deal with Y and Z, etc.), or to 
highlight specific pertinent language from 
a document. For appropriate materials 
from the internet your brief cites, remem-
ber—some internet links expire. If you 
have the pdf in your Appendix, it is always 
available.

A few other tips.
A picture is worth a thousand words, and 
does not count against your word limit.

Over two thirds of justices find “graphs, 
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charts, and pictures in the body of the 
brief” helpful.13  The late Bob Burleson, 
a really great trial lawyer for whom Steve 
clerked, used to tell him to have fun with 
a brief—and in the pre-computer days 
of Liquid Paper® and Xerox® machines, 
would interlace his briefs with appropriate 
Peanuts® cartoons. Robert DuBose recent 
paper has many excellent examples of this 
tool.14 

Quote authority from the Texas Su-
preme Court and the Court in which you 
file your brief.

Eighty-five percent of justices prefer 
you cite authority from the Texas Supreme 
Court and authority from their court.15 If 
you show them they have followed control-
ling Supreme Court precedent, they will do 
so, again, for you.

Don’t personally attack the trial court 
or opposing counsel—ever.

Judicial panels perennially give this 
advice. One justice even said such personal 
attacks are so distracting that, when she 
encounters one, she puts the brief down, 
clears her mind, and restarts the brief at 
the next issue. So not only do you not 
make your point, you have shut down your 
input on the issue.

After the Ball Is Over.16

With appropriate leave of court, a short 
one paragraph or one-page post argu-
ment letter can be very useful—to respond 
to a question that stumped you at oral 
argument, or to inform the court of new 
authority. Do not use these letters to just 
rehash old stuff, or, like the aging uncle in 
the song, you will rue the day you misused 
this opportunity. When facing another 
party’s mandamus, you might consider 
sending the court a one-page letter which 
expressly reserves your right to fully 
respond, should the court desire—while 
pointing to the particularly glaring reason 
the mandamus should fail.

Other Resources
Lengthier papers abound concerning brief 
writing—the SBOT Appellate Section 

makes literally dozens of such papers avail-
able to its members.17 New papers surface 
regularly at CLE Courses run by the State 
Bar of Texas (e.g., Advanced Civil Appel-
late Seminar, Appellate Law 101 Seminar, 
Handling Your First (or Next) Appeal) and 
the University of Texas (e.g., Conference 
on State and Federal Appeals). You should 
also review the Surveys of the courts of ap-
peals which this paper has referenced. 

Hopefully, the foregoing will get you 
going on your brief in a way that makes 
you useful—to the courts and your cli-
ents—as well as ornamental.

Steven K. Hayes is a solo appellate 
practitioner in Fort Worth, Texas, Chair-
Elect of the SBOT Appellate Section, and 
Council Member of the SBOT Litigation 
Section.

Brittani Wilmore Rollen practices at 
McDonald Sanders in Fort Worth, Texas, 
where she focuses on commercial litigation 
and appeals. 

Justice Sue Walker is a Justice on the 
Second Court of Appeals in Fort Worth, 
Texas, and is Board Certified in Civil Ap-
pellate Law.

Dabney Bassel is a solo appellate prac-
titioner in Fort Worth, Texas, and is Board 
Certified in Civil Appellate Law.

Constance K. Hall is an Arlington, 
Texas, attorney handling Business, Estate 
Planning & Probate, and Appeals, and is a 
former Briefing Clerk to the Second Court 
of Appeals in Fort Worth, Texas.

1  Jane Hayes, the Mother of one of the authors, 
was fond of this general admonition, which applies 
to brief writing.
2  We focus here on writing briefs in Texas courts 
of appeals. If writing for a different court, then 
adjust the advice given here to accommodate for 
different pertinent rules, and your audience.
3  Comments of Scott Brister, former Justice 
of the Supreme Court of Texas, at State Bar of 
Texas CLE PRACTICE BEFORE THE SUPREME 
COURT 2009, Suggestions About Oral Argument.
4   Stacey Stanley, Staff Attorney, Sixth Court of 
Appeals, Texarkana; p. 24, Rehearing Practice in 
the Courts of Appeals, SBOT 24th Annual Advanced 
Civil Appellate Seminar (2010).
5  P. 1, Results of the 2009 Judicial Survey, SBOT 
Appellate Section;   A subsequent Judicial Survey 

was performed in 2012; as of the writing of this 
paper, that Survey was only available through 
UT Law CLE, and we do not link to it here. See 
P. 2, Rothenberg, Scott, Rutter, Kent, and Storey, 
JoAnn, Results of the 2015 Judicial Survey, 25th 
Annual Conference on State and Federal Appeals 
(2015).
6  P. 3, 2009 Survey.
7  P. 2, 2009 Survey.
8  Bookmarking is surprisingly easy. See pp. 20-
25, Guide to Creating Electronic Briefs, by Blake A. 
Hawthorne, Clerk of the Supreme Court of Texas, 
found on the Supreme Court’s website.
9  P. 2, 2009 Survey; P. 2, 2015 Survey.
10  Pp. 2-3, 2009 Survey; P. 2, 2015 Survey.
11  Id.; in 2015, nearly 70% felt this way. P. 4, 2015 
Survey.
12  Id.
13  Id.; in 2015, nearly 83% felt this way. P. 4, 2015 
Survey.
14  Dubose, Robert, Briefing Visually, 26th Annual 
UT Conference on State and Federal Appeals 
(2016).
15  P. 2, 2009 Survey.
16  Jane Hayes would sometimes sing the refrain 
to this song to her children when they were young, 
and not so young.
17  For some recent papers, see:  Baruch, Chad, 
Legal Writing:  Lessons from the Bestseller List, and 
Dubose, Robert B., Brief Structure, Format, and 
Design, SBOT Handling Your First (or Next) Civil 
Appeal (2016); Dove, Christopher, Selecting and 
Framing Issues on Appeals, SBOT Civil Appellate 
Practice 101 (2015); Brister, Scott, and Gray, Ken-
dall, Extreme Brief Makeover, UT Conference on 

State and Federal Appeals (2014); Hawthorne, 
Blake, and Cruse, Don, Electronic Briefs 
Nuts and Bolts, UT Conference on State 
and Federal Appeals (2011).

Steve Hayes is 
a solo appel-
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Harvard Law School, Chaired the State Bar 
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late Section, and the Bell-Lampasas-Mills 
Counties Young Lawyers Association.  The 
Tarrant County Young Lawyers’ Association 
selected him as Mentor of the Year in 2010.
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The Impact of Child Support on Adult Children  
with Special Needs 
By Jonathan Glusband

Monday morning. 10 A.M. 

An attorney in your office brings in a new case. You soon learn that the new client has 
three children, one of which is a 19 year old with special needs. One of your client’s 
biggest concerns is managing the needs of the 19 year old with special needs. Your cli-
ent is worried about pre-existing expenses for the child, potential modifications to her 
residence, as well as all of the costs of paying professionals to assist the child. Before the 
attorney, the client or you even start thinking about potential child support for the child, 
you must determine if the child has qualified for any government benefits and then 
evaluate how child support payments would affect those benefits. 

The most common benefits to be aware of are Medicaid and Supplemental Security 
Income (SSI). In a nutshell, Medicaid is the government health care program for low-
income individuals, while the Supplemental Security Income Program (SSI) is a monthly 
income assistance program which helps qualified individuals pay for food, clothing, and 
shelter.

While SSI benefits are not that substantial in Texas, SSI recipients automatically 
become eligible for Medicaid, which in turn can lead to greater benefits such as paid 
hospital stays, doctor bills, prescription drugs and even nursing home care. 

After speaking to your new client, you find out that the 19 year old child with special 
needs meets the initial requirements for SSI. What now? Your next step is to understand 
what the income limits, potential “in-kind support”, and resource limits are for a person 
eligible for SSI. 

In Texas, the income limit for eligibility is tied to the maximum allowed federally, 
which for 2017 is $735.00 a month for an individual and $1103.00 for a couple. What 
that means is that if a person’s income falls below those limits, he or she is eligible for 
benefits and that benefit will be the difference between his or her income and the maxi-
mum allowed. So if a person has income of $300.00 a month, SSI will provide $435.00 to 
that person (maximum of $735.00 minus $300.00 in income). What is income you ask? 
Included in the definition are; money earned from wages or self-employment, invest-
ment income, gifts, rents and interests and annuities. Additionally, some dollar amounts 
are excluded from total income depending on the type of income. 

Related to income limits is the issue of determining if an individual is receiving what 
is known as “in-kind support” from a parent, friend or relative. In-kind support and 
maintenance (also commonly referred to as “ISM”) is unearned income in the form of 
food or shelter, or both. The Social Security Administration views food or shelter one 
receives as equal to one-third of the SSI benefit, and as such will reduce the benefit by 
that amount. 

A potential reduction is not considered if the individual lives alone and pays for their 
own food and shelter; if the individual lives only with their spouse and minor children, 

A
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and nobody outside household pays for 
food and shelter, or lives with other people 
and pays their share of the food and shel-
ter.

Reductions could also be avoided if an 
individual is given food or shelter as a loan 
and pays it back. 

Now on to resources. A person can 
have a maximum amount of $2,000.00 
in countable resources ($3,000.00 for a 
married couple) in order to be eligible for 
SSI. The definition of countable resources 
includes; bank accounts, investments, real 
estate (not including primary residence) 
and personal property. Like any rule, there 
are some exceptions. These exceptions 
include an applicant’s home, the land 
the home is on, personal and household 
goods, as well as one vehicle so long as the 
vehicle is used for the transportation for 
the applicant or applicant’s family. 

Now that we understand the interplay 
between income, resources and SSI eligi-
bility, we can finally examine how child 
support payments affect SSI and Medicaid. 

SSI defines child support as in-kind or 
cash payments to a child or a child’s legal 
representative or custodian to meet the 
child’s needs for food and shelter. For a 
child 18 or older, one hundred percent of 
a child support payment (minus $20.00 
as an exemption) counts as a reduction 
against SSI. For example, if a child sup-
port payment is $300.00, a $735.00 maxi-
mum SSI payment would be reduced by 
$280.00 (the $300.00 payment minus the 
$20.00 exemption), which would lead to a 
new SSI payment of $455.00. While child 
support would lead to a total of $755.00 
a month, (the $455.00 plus the support 
payment of $300.00), the addition of the 
child support only created an extra $20.00 

benefit to the child. 
Where this situation gets dangerous 

is when child support exceeds the SSI 
income limits. While dollar amounts are 
not harmed (in the above example the 
child receives a net gain of $20.00 dollars 
from the child support), SSI eligibility 
could be harmed if the amount of support 
exceeds the SSI income limit, which in 
turn will lead to a loss of Medicaid and all 
the benefits that come along with it. 

To protect SSI and Medicaid benefits 
AND still receive child support, there are 
a few tools that can be employed. These 
options include a special needs trust, 
spousal maintenance and annuities. 

A special needs trust is designed to 
hold assets of a person receiving public 
benefits, such as SSI and Medicaid. If a 
divorce decree directs the non-custodial 
parent to make child support payments 

ATTENTION LITIGATION STAFFATTENTION LITIGATION STAFF
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to a special needs trust for the sole benefit 
of a child, then the valuable government 
benefits the child receives can be pro-
tected. This trust must be carefully drafted 
in order to not displace the monthly SSI 
payments. Essentially, by not directly 
supplying an adult disabled child with a 
child support payment, the adult disabled 
child’s income will not be increasing in the 
eyes of the government. 

Another alternative would be to set up 
and ABLE account for the person with dis-
ability and have the support paid into the 
ABLE account. A maximum of $14,000 per 
year may be put in an ABLE account. The 
ABLE account may be used for the ben-
efit of the person with benefits, without 
counting as income for the person with 
disability.

Spousal support or contractual alimony 
paid directly to the parent of an adult 
child, in lieu of child support to the adult 
child, will also not be considered income 
of the adult child. This money could then 
be applied to the care of the adult child 
without interfering with SSI payments or 
Medicaid benefits. Some clients may say 
that they don’t need a child support order 
and the supporting parent will just vol-
untarily and informally pay support. This 
option also comes with risk. The Social 
Security Administration, might impute 
child support if none is Order that could 
but doesn’t provide support, which would 
reduce the SSI benefits by the amount of 
imputed support. It is best to have the 
Order provide some amount of support. 

Jonathan Glusband is 
an Associate Attorney 
with Noelke Maples 
St. Leger Bryant, LLP 
in Austin, Texas. Jon 
graduated from the 
George Washington 
University Law School 
in Washington, D.C., 

where he was named a Thurgood Marshall 
Scholar and was a member of the Public 
Contract Law Journal. Before joining Noelke 
Maples St. Leger Bryant, Jon practiced law 
in New York City, where he was a Felony 
Assistant District Attorney in the Brooklyn 
District Attorney’s office. With a background 
in criminal law and civil litigation, Jon is 
now exclusively focused on the practice of 
family law. nmsb-law.com
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FRI, April 20, 2018— Depart from the USA to Europe.
SAT, April 21, 2018 (Bruges)— Morning arrival and transfer to Bruges. 

This evening enjoy a special welcome dinner to kick off your trip. 
(D)

SUN, April 22, 2018 (Bruges)—This morning you will enjoy a guided 
walking tour which highlights the best preserved Renaissance 
architecture in all of Europe and also includes a visit to a lace center 
with demonstration. Bruges is famous for its lace, one of the oldest 
hand worked crafts in the world, and has been since the early 1700’s. 
You’ll also visit a diamond museum and learn that diamonds were 
traded in Bruges long before diamonds were heard of in Antwerp 
and Amsterdam. Later you will visit the Groeningemuseum. In the 
afternoon, discover Bruges by boat on a relaxing canal cruise. (B)

MON, April 23, 2018 (Bruges)—Today enjoy an excursion to Brussels. 
Today’s sightseeing with a local guide begins with a drive to the 
Royal Domain at Laeken, residence of the Belgian royal family, and 
the famous Atomium. Return to town to see the European Parlia-
ment, the imposing Palace of Justice, St. Michael’s Cathedral and the 
neo-classical Place Royale. You will continue to the antiques district, 
the Sablons, before viewing the iconic statute Manneken Pis and 
the breathtaking square that has become emblematic of the Belgian 
capital, the Grand-Place. After lunch visit the EU complex and main 
commission building. Return to Bruges this evening. (B,L)

TUE, April 24, 2018 (Bruges)—This morning you are free to discover 
Bruges. In the afternoon, you will enjoy a chocolate workshop and 
tasting. Then you will enjoy a tasting of local beer. (B)

WED, April 25, 2018 (Amsterdam)—Early morning departure for a visit 
to Kinderdijk including the museum, windmill and pumping station 
“Wisboomgemaal”. Stop in Delft for lunch and a guided visit of 
the Royal Delft Factory. In the afternoon follow the tulip route to 
Amsterdam. (B, L)

THU, April 26, 2018 (Amsterdam)—Enjoy a morning city sightseeing 
tour including the Rijksmuseum. After a free afternoon enjoy a 
Rijsttafel dinner. (B, D)

FRI, April 27, 2017 (Amsterdam)—Today is a free day to perhaps visit the 
famous Keukenhof Gardens, Anne Frank’s House or the Van Gogh 
museum. Relive the highlights of your trip on your private farewell 
dinner canal cruise. (B,D)

SAT, April 28, 2018—Depart for the USA. (B)

FEE WITH AIR INCLUDED:  Fee is based on registration by November 
1, 2017. 

Fees:  Departing DFW– $4,629; Austin/San Antonio—$4879; Hous-
ton—$4839; Amarillo—$4959; Midland—$4,899; Abilene—$4,979 
(includes program fee). Note:  Registrations after August 1 may 
include additional fuel surcharges that are finalized 45 days prior 
to departure; an invoice will be sent at that time if there are any 
increases. Other departure cities available upon request. Fees based 
on 20 persons and includes airfare, hotel, transportation, tours, and 
meals as indicated above.

Additional/Optional fees:  Single room supplement:  $859; Ultimate 
Protection Plan:  $270; Comprehensive Protection Plan:  $225; Sur-
charge for guests ages 66+:  $100

LAND ONLY FEE: (if you wish to make your own air travel arrange-
ments):  $3,529 

PAYMENT SCHEDULE:  Deadline for registration is November 1, 2017; 
Initial non-refundable deposit is $200; another $295 payment will be 
due 30 days after registration, third payment of $500 is due Novem-
ber 1, 2017; fourth payment of $500 is due on December 1, 2017, with 
balance due on January 15, 2018. Non-payment of required on-time 
monthly payments will result in trip cancellation. 

MAKE IT EASY ON YOURSELF! SIGN UP FOR AUTO PAYMENTS:  
Automatic Payments plan available. Automatic Payments makes 
planning your trip budget easy because your payments are spread 
out evenly, giving you more time to pay. You choose a payment 
frequency (every 2 weeks, every 4 weeks, monthly, or quarterly) 
and your payments are automatically deducted from your check-
ing or savings account. Travelers who use autopay will be given a 
$50 discount. Automatic Payments are available for all registered 
participants in “My Account:” at www.acis.com/accounts.   

EXTENSION:  To extend stay at the end of the trip, an Alternate Re-
quest Form must be completed (found at https://www.pdffiller.
com/217790774-2016-Alt-Return-Formpdf-2016-Alternate-Return-
Request-Form—ACIS-Educational-Tours-Various-Fillable-Forms) 
and returned to ACIS at least 90 days prior to your trip’s departure.  
There will be an additional fee of $175 for this extension, plus any 
additional airline ticket costs. 

REGISTER at http://www.acis.com/register choose Participant from 
the drop-down menu and sign in using: Group Leader ID: 46775- 
Group Leader’s Last Name: Brashears - Click on the appropriate 
circle for your departure city for the “Bruges, Brussels and Amster-
dam” trip and fill in your information.

Paralegals Fly to Brussels, Bruges and Amsterdam
April 20–April 28, 2018 (Eight Days and Seven Nights)



26  texas  paralegal  journal fall  2017

Recapping The Sunset Commission’s Impact on the 85th Legislative Session
Donna Lynn  Waldon, TBLS-BCP
Mary R. Wintermote 

2017 marks the 40th anniversary of the  Texas Sunset Act 
which was passed by the 69th Legislature. The Act created 

a 12-member Sunset Advisory Commission to review a certain 
number of the 130 state agencies every twelve years and make 
recommendations about whether the specific agency should 
be continued, improved, or phased out. During 2016-2017, the 
Commission reviewed twenty-five state agencies and adopted 
recommendations on continuing, dissolving, or improving these 
agencies. 

By the May 29, 2017 conclusion of the Legislature’s Regular 
Session, five agencies—Texas Medical Board, Texas State Board 
of Social Workers Examiners, Texas State Board of Examiners of 
Marriage and Family Therapists, Texas State Board of Examiners 
of Psychologists and Texas State Board of Examiners of 
Professional Counselors—had not received approval to continue 
on a two-year “safety net” legislation regarding these five agen-

cies. House Bill 2561 and House Bill 2590 , which were introduced 
during the General Session, impacted several of the reviewed 
agencies as those bills dealt with control, monitoring, and report-
ing on prescribing, dispensing, and use of controlled substances. 

On July 10, 2017, Governor Abbott declared a special session 
of the Legislature to convene beginning on July 17, 2017 for the 
purpose of extending the expiration dates of the five agencies. 
Upon reconvening, Senate Bill 20 and Senate Bill 60 introduced 
by Senator Van Taylor proposed amending Section 151.004 of 
the Occupations Code to reauthorize the affected agencies. The 
bills passed unanimously shortly after midnight on July 20, 2017. 
Should the House not approve the bills by a 2/3 margin, they will 
come in effect on the 91st day after conclusion of the special ses-
sion.

Significant information related to the twenty-five agencies 
includes: 

Agency1   Comment

State Bar of Texas, State SB320 continues the State Bar agency for an addition 12 years. 
It also provided powers to the Office of the Chief Disciplinary 
Counsel regarding monitoring and action against unethical 
attorneys and improvements to the Bar’s rulemaking process.

Central Colorado River 
Authority (CCRA)

SB 2262 abolishes the CCRA on January 1, 2019 and the 
answers of the Agency will be transferred to Coleman County 

Texas Board of Chiropractic 
Examiners 

SB 304—Deregulates chiropractic facilities, requires the Board 
to use chiropractic experts to investigate complains. Requires 
fingerprint, background a disciplinary action checks before 
issuing or renewing a license. Address issues related to “bottle-
necks in the complaint resolution process” as well as linking 
penalties to risk.

Texas State Board of Examiners 
of Professional  Counselors, 

 Texas State Board of 
Examiners of Professional 
Marriage and Family 
Therapists 

 Texas State Board of 
Examiners of Professional  
Social Workers Examiners, 
Texas State Board of 

HB 2898 containing the Sunset Commission’s recommenda-
tion for the three behavioral science examination boards did 
not pass. However, several non-statutory management actions 
are to be adopted 

State Board of Dental 
Examiners 

SB 313 strengthened anesthesia regulation and provided meth-
ods to enforce the regulation, improved training and require-
ments for emergency preparedness and provided evidence-
based review regarding additional changes in anesthesia 
regulation

Board of Trustees of 
Employees Retirement System 
of Texas 

SB 301 requires the Agency Board to approve individual 
alternative investments and track and report profit shares for 
these investments in an attempt to increase Agency oversight 
and transparence. The bill also requires the Agency to provide 
additional group benefit information and develop a process 
for members to participate in insurance appeals. 

Health Licensing 
Consolidation Project 

HB 2878, which would have merged the licensing and regula-
tions of psychologists, marriage & family therapists, profes-
sional counselors, social workers and chemical dependency 
counselors, did not pass. 

Hot
 “C

ites
”

Board of Law Examiners SB 303—The Commission originally looked at the board 
structure separating the licensing and examination of attor-
neys from the State Bar of Texas’s enforcement activities and 
concluded that the current structure of the two agencies was 
standard across the United States and performed its duties 
well. SB 303 removed several statutory barriers and inconsis-
tencies to promote efficiency. Several management actions, 
not requiring legislative action, were also adopted. 

Texas Medical Board, Neither HB 3040 or SB 315 passed, however, several of the 
Commissions other recommendations were passed under sep-
arate legislative including:  HB2561 related to the Prescription 
Monitoring Program; SB 315—Regulations regarding Pain 
Management Clinic; SB 1625—Requiring at least one physi-
cian’s assistant to serve as a panelist in settlement conferences 
regarding a physician’s assistant; SB 1625—Related to licensing 
of physician’s assistant SB 674—Regarding licensing and dual 
registration provisions for various medical professionals. 

Texas Board of Nursing HB 2950 limits subjective standards used by the Agency to 
discipline nurses and continued the exception to licensing 
requirements to Excelsior College’s nursing program and 
creates a similar licensing process for other in-state programs. 
Additionally, the bill added to the Board’s peer assistance pro-
gram and discussed issues related to overprescribing certain 
drugs. It also addressed restrictions on the board’s hearing 
process, religious freedom protections and allowed advanced 
practice registered nurses to sign death certificates. 

Texas Board of Occupational 
Therapy Examiners 

Texas Board of Physical 
Therapy Examiners 

Both the Occupational Therapy Examiners Board and Physical 
Therapy Examiners Board had not been reviewed by the 
Commission for 23 years so there had not been an overview 
of the Board’s regulations. Through SB 317, the boards will no 
longer be required continue with the requirement to register 
physical and occupational therapy facilities after September, 
2019. The bill takes advantage of regulatory activity for physi-
cal and occupational therapists to cross state lines and updates 
the agency statutes and practices to comport with current 
standards. 

Texas Optometry Board SB 314 requires optometrists to have a fingerprint-based 
criminal background check. HB 2561 comports with the 
other health licensing agencies by requiring optometrists 
with prescription writing authority to search the Prescription 
Monitoring Program database and conduct a patient review 
before prescribing controlled substances. HB 2561 also 
requires the board to search the database periodically to iden-
tify any improper prescribing patters. 

Palo Duro River Authority 
of Texas 

Through HB 1920, the Palo Duro River Authority is restruc-
tured to become a local water district and allows the district 
to decide its own future through an optional member dis-
solution practice
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Hot “Cites”
 Texas State Board of Pharmacy HB 2561 addresses the prescription drug abuse epidemic 

and implanted national best practices for the Prescription 
Monitoring Program including requiring pharmacists to enter 
data more quickly and check the database before prescrib-
ing high risk controlled substances. It also requires doctors, 
nurses and licensing board to use the system proactively as 
detailed in each related agency’s report. The bill also contains 
recommendations to improve the licensing and enforcement 
processes and updates processes for board training, rulemak-
ing and dispute resolution. 

Executive Council of Physical 
Therapy and Occupational 
Therapy Examiners 

This board had not been reviewed by the Commission for 23 
years. SB 317 continued the PT and OT boards for 12 years. The 
board no longer needs to continue the registration require-
ment to register physical and occupational therapy facilities. 
SB 317 also recommended that the agency statutes and prac-
tices be updated to refl ect current standards.

Texas State Board of Podiatric 
Medical Examiners 

 HB 3078 transfers the agency’s functions to the Texas 
Department of Licensing and Regulation (TDLR) on 
September 1, 2017. The TDLR will provide stability and 
savings, address slow complaint resolution responses and 
improve licensing & enforcement outcomes. HB3078 also 
updates licensing and enforcement practices and, consis-
tent with House Bill 2561, requires podiatrists to search the 
Prescription Monitoring Program (PMP) database and review 
a patient’s prescription history prior to issuing certain pre-
scription medications. 

Texas State Board of Examiners 
of Psychologists 

HB 2898 contained the Commission recommendations for the 
board did not pass; however, the Commission adopted several 
nonstatutory management actions the board is required to 
implement. 

Railroad Commission of Texas HB 1818 requires that the Railroad Commission develop a plan 
tracking and measuring its enforcement program, including 
conducting audits of severed leases to deter illegal production 
of oil and gas. The bill also makes the Commission’s recom-
mendations to provide resources for pipeline safety, pipeline 
damage production and develop an alternative dispute resolu-
tion policy. 

Sulphur River Basin Authority As a result of controversies regarding water development 
projects, HB 2180 essentially resets the board and allows the 
SRBA to reestablish positive working relationships and trust 
to better the Sulphur River basin area. The Commission 
made recommendations regarding funding, contracting and 
improved transparency.

Texas Department of 
Transportation 

SB 312 attempts to ensure that TxDOT continues to progress 
to a more transparent, performance based planning and 
project selection process, addressed ineffi ciencies within the 
department authorized additional tools to improve the timeli-
ness of its construction projects. The bill also advanced the 
Commissions’ desire to increase accountability for the use of 
the state aircraft fl eet and modernize vehicle crash reporting. 
Several provisions related to toll road fi nancing, user fi nes on 
TXDOT toll roads and public communication. 

Upper Colorado River 
Authority 

In accordance with the Commission’s recommendations, HB 
1921 clarifi es the Authority’s boundaries and increases the 
board’s role in  identifying priorities to strengthen relation-
ships with local partners

State Board of Veterinary 
Medical Examiners 

SB 319 and HB 2561 addressed inadequate monitoring related 
to dispensing controlled substances and automatically regis-
tered veterinarians to use the Texas Prescription Monitoring 
Program database. Additionally, the board is required to 
monitor, identify and investigate potentially harmful pre-
scribing and dispensing patterns. The legislature did not adopt 
the Commission’s recommendation requiring veterinarians 
to report their controlled substance dispensing to clients’ 
animal-related prescription history. SB 319 hopes to improve 
the agency’s enforcement process with regard to fair treatment 
of complainants and licensees while increasing transparency 
and information access, while protecting complaint confi -
dentiality. 

Donna Lynn Waldon 
is Professional 
Development 
Committee Chair 
of the Paralegal 
Division of the State 
Bar of Texas and has 
worked as a paralegal 
for 15 years.  Donna 

Lynn was certifi ed in Family Law by the 
Texas Board of Legal Specialization in 
2015.  She is a family law paralegal and is 
currently working in the Southlake offi ce of 
KoonsFuller, P.C., which has fi ve offi ces—
Dallas, Denton, Plano, Southlake, and 
Houston.  koonsfuller.com 

Mary R. Wintermote 
is Secretary and 
District 3 Director of 
the Paralegal Division 
and has worked as 
a paralegal for 27 
years. Mary is a senior 
litigation paralegal in 
the Fort Worth offi ce 
of Cotten Schmidt & 

Abbott, LLP. She works collaboratively on 
complex litigation matters fi led nationwide 
along  with the fi rm’s New Orleans, Houston 
and Corpus Christi offi ces, assists with 
technology training and serves as liaison to 
several of the fi rm’s major clients. www.csa-
lawfi rm.com

1 The Sunset Commission’s fi nal report is hyperlinked to each individual 
Agency discussed in this article. 
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Scruples
Ethical Considerations Regarding Paralegals 
and Privileged Communications-Client 
Privilege
Ellen Lockwood, ACP, RP

A
s paralegals, we are fre-
quently responsible for 
transmitting questions and 

confidential information from clients to 
attorneys, and advice and guidance from 
attorneys to clients. Paralegals are often 
more available to clients than busy attor-
neys and have more access to the attorneys 
handling the matter. Paralegals also have 
lower billing rates, so if a conversation 
with a client will take a few minutes, it will 
be less expensive to have the conversation 
with the paralegal.

All information regarding legal mat-
ters is confidential and some of the 
information will also be considered privi-
leged. Attorney-client privilege is a well-
established doctrine of common law. The 
required elements are as follows:

a statement that seeks or provides legal 
advice
made between an attorney and the 
attorney’s client
made in confidence
for the purpose of seeking, obtaining, or 
providing legal assistance to the client

Several federal decisions have clarified 
when communications between a non-
attorney and a client may be considered 
privileged. The federal courts have eluci-
dated that the communication must have 
been made for the purpose of obtaining 
legal advice from the attorney. The ele-
ments required for a communication to 
be subject to attorney-client privilege is 

another reason why it is important to 
make clear to clients when advice and 
guidance is coming from the attorney. 
Statements such as “I passed along your 
question to attorney _______ and she 
advised . . .” or “I spoke to attorney 
________ who asked me to tell you . . .” 
will alert the client that the information is 
from the attorney, not the paralegal. Such 
clarifications also help paralegals avoid 
claims that the paralegal is engaging in the 
unauthorized practice of law. (Of course, 
this assumes paralegals have actually con-
sulted their attorneys regarding the appro-
priate responses to the clients.)

Communications with clients can 
be an especially complicated area for 
non-attorneys who provide guidance to 
clients without constant involvement of 
attorneys, such as within a corporation. In 
HPD Laboratories v. The Clorox Company, 
202 F.R.D. 410 (D.N.J. 2001), HPD filed 
a motion to compel discovery of com-
munications between a paralegal and the 
business people. The Clorox paralegal’s 
job duties included advising the business 
people regarding marketing and regulatory 
matters. Clorox argued that the commu-
nications were privileged. However, the 
judge ruled that under federal law, these 
communications did not meet the criteria 
of privileged communications. Since the 
business department did not consult with 
the paralegal for the purpose of obtain-
ing legal advice from an attorney, and the 
paralegal gave her advice independently 

rather than assisting the attorney in for-
mulating and providing legal guidance, the 
judge’s decision was that the communica-
tions did not meet the required elements 
to be considered privileged. 

Although the Clorox case involved an 
in-house paralegal, the same issues are also 
a concern for paralegals who work in law 
firms. Paralegals and attorneys should not 
assume all communications between non-
attorneys and clients automatically meet 
the criteria to qualify as privileged. Clients 
may assume every communication they 
have with anyone in the attorney’s office 
is not only confidential, but also privi-
leged. Legal teams should take care that all 
privileged communications meet the legal 
requirements. 

Written communications that include 
legal advice should be signed by an attor-
ney. If legal advice is being sent to a client 
via email from the paralegal, the attorney 
should be copied on the email and the 
email should be worded to make it clear 
the advice is coming from the attorney.

Ultimately, it is the responsibility of 
attorneys, with assistance from paralegals, 
to ensure any privileged communications 
meet the requirements to be designated as 
privileged, and will be likely to withstand 
legal scrutiny and challenges.

Ellen Lockwood, 
ACP, RP, is the 
Chair of the 
Professional 
Ethics Committee 
of the Paralegal 
Division and a 
past president 
of the Division. 
She is a frequent 

speaker on paralegal ethics and intellec-
tual property and the lead author of the 
Division’s Paralegal Ethics Handbook pub-
lished by Thomson Reuters. You may follow 
her at www.twitter.com/paralegalethics 
and she may be contacted at ethics@txpd.
org.
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Paralegal Division
State Bar of Texas

Board of Directors 
Quarterly Board Meeting Summary

June 2017 
 

Submitted by President-Elect, Stephanie R. Sterling, TBLS-BCP

The Paralegal Division Board of Directors has been 
very busy this last year. Here are some interest-
ing highlights from the last quarterly meeting in 

June. 

Online Membership Renewals
Membership renewals are being processed strictly online 
effective beginning this past May. The Board of Directors 
would like to remind all active and associate members to 
be sure to keep their CLE updated on their membership 
profi le. 

New Membership Bar Cards
A one-time Membership Bar cards will be issued to 
renewing members this year instead of receiving a new 
card every year. Members are encouraged to hold on to 
this card, however replacement cards will be available 
for a nominal fee should you happen to misplace or lose 
your card received this year. 

Digital TPJ
The Texas Paralegal Journal (TPJ) is fully digital now, so 
be sure to read it when the e-blast with the link to access 
it is sent out to the membership. You can read past print 
and electronic issues HERE.

Governing Documents Committee
The Governing Documents committee is busy making 
sure that all of our Governing Documents are cohesive 
and up to date. At this last meeting in June, the Board 
approved to add the Texas Paralegal Standards to the 
Paralegal Division’s Standing Rules as Appendix 1 for the 
purpose of more member visibility and access. These 
“Standards” were approved by the State Bar of Texas 

Board of Directors in 2006 to assist attorneys in their 
utilization of paralegals. 

New Ethics CLE Requirement 
In keeping with the Paralegal Division’s vision of 
empowering paralegals, the Board of Directors passed 
a new CLE requirement. Effective for the 2017–2018 
Renewal Period, all active and associate members will be 
required to have one (1) hour of the current six (6) hour 
requirement in ethics by May 31, 2018.

Online Store
Get your Paralegal Division logo merchandise at the PD 
Online Store. TAPS merchandise was recently added to 
selections. 35th Anniversary merchandise is still avail-
able, but only for a limited time. 

Board of Directors and Committees
We are hard at work for you - Get to know your Board 
of Directors and Committee Chairs. 

Paralegal Pulse
The Paralegal Division’s monthly e-newsletter sent out 
to the membership on or about the 15th of the month. 
Did you know that you can access the Paralegal Pulse 
archives online?

Paralegal Division Blog
Read and subscribe to the PD Blog

Social Media—Follow, Like or Join
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2017 ANNUAL MEETING
By Jay M. Williams, TBLS-BCP

District 2 Director

The 2017 Annual 
Meeting of the 
Paralegal Division, 

State Bar of Texas, took place 
on June 23, 2017 at the Crowne 
Plaza Dallas Galleria Hotel. 
Under the guidance of Melody 
Johnson, CP, the committee 
planned topics that allowed 
attendees to receive TBLS 
approved CLE on topics fol-
lowing the theme, “Writing 
and Cloud Storage: The 
Paralegal’s New Legal Pad.” 
Starting with Tom Mighell’s 
presentation of “Collaboration 
and Productivity Tools for 
Law Firms—2017 Update,” fol-
lowed by Robert Bogdanowicz, 
III’s presenting “Your Case in 
the Cloud: Avoiding Ethical 
Pitfalls & Security Issues When 
Using Cloud Storage,” Peter 
Vogel gave a very entertaining 
yet fascinating presentation 

to “Keep Investigations about 
Cyber Intrusions in the U.S. 
and Around the World.” Once 
again, the Paralegal Division 
was a beneficiary of the sup-
port of our wonderful vendor 
members. Led by our Gold 
Level Sponsors Veritext, Kim 
Tindall & Associates, File & 
Serve Xpress, DepoTexas/
Lexitas, and Metro Video, the 
Division benefitted from sev-
eral sustaining members sup-
porting our event.

During the business portion 
of the meeting Parliamentarian 
Stephanie Sterling, TBLS-BCP, 
reminded the attendees of the 
Division’s Canons of Ethics. 
Then, Outgoing President 
Megan Goor, TBLS-BCP, 
gave the State of the Division 
address. We continue to 
remain strong and viable as an 
association. Treasurer Jay M. 

Williams, TBLS-BCP, informed 
attendees the Division is in a 
strong fiscal position namely 
due to the following of proce-

dures by District Directors and 
Committee Chairs while carry-
ing out their fiduciary duties to 
the Division.

Outstanding Chair Award—
Susan Davis, TBLS-BCP

Special Appreciation Award—Deb Pointer 

Special Recognition Award—Vicki Lorenzen with District 7 Director,  
Sharla Fowler, CP



Next, the Division recog-
nized the outstanding work 
of various members through-
out the preceding term. Julie 
Sherman, TBLS-BCP, present-
ed the Exceptional Pro Bono 
Award to Katrina Lea (District 
3) for her tireless work in the 
legal community and serving 
as an advocate for those with 
limited means or who are 
unable to speak for themselves.   

The Special Appreciation 
Award was presented to Deb 

Pointer (District 3) who serves 
in many capacities for District 
3 (Membership sub-chair and 
Spot Audit co-chair) and is 
always one to step in and help 
with whatever else might be 
needed. 

An Outstanding Chair 
Award was given to Susan 
Davis, TBLS-BCP (District 
3), Vendor Liaison Chair, for 
her continued efforts in get-
ting sponsorship for events 
across the state and increasing 

networking opportunities for 
sustaining members. A second 
Outstanding Chair Award was 
given to Sheila Posey, TBLS-
BCP (District 10), E-Newsletter 
Chair and Editor, for putting 
together and providing impor-
tant information and news 
in the “Paralegal Pulse” every 
month. The Special Recognition 
Award was given to Vicki 
Lorenzen (District 7) for her 
persistent and tireless efforts to 
formulate a new area of board 
certification for paralegals in 
oil, gas and mineral law, which 
came to fruition earlier this 
year. A President’s Award was 
awarded to PD Coordinator, 
Rhonda Brashears, CP, TBLS-
BCP, for her remarkable 
work and exceptional service 
as the Paralegal Division 
Coordinator. 

 The prestigious Award 
of Excellence was given to 

President-Elect, Stephanie 
Sterling, TBLS-BCP, (District 
4) for her outstanding and her-
culean achievement as Chair 
of the Governing Documents 
Committee.

Afterward, Outgoing 
President Goor passed the 
gavel to Incoming President 
Mona Hart Tucker, ACP. 
Then came the installation of 
the Board of Directors and 
Executive Committee for the 
2017–18 term. The Board of 
Directors consist of Sherylyne 
Hollinger, RP, PHP (District 
1); Jay M. Williams, TBLS-BCP 
(District 2); Mary Wintermote 
(District 3); Pamela M. Etie, 
ACP (District 4); Susi Boss 
(District 5); Sharla Fowler, CP 
(District 7); Jennifer Barnes, 
CP (District 10); Sandra 
Seutter (District 11); Michelle 
Beecher (District 12); Javan 
Johnson, ACP, TBLS-BCP 
(District 14); Enda W. Garza, 
TBLS-BCP (District 15); and 
Rebecca Lopez (District 16). 
The Executive Committee 
for the 2017–18 term con-
sists of President Mona Hart 
Tucker, ACP; President-
Elect Stephanie Sterling, 
TBLS-BCP; Treasurer Javan 
Johnson, ACP, TBLS-BCP; 
Secretary Mary Wintermote; 
and Parliamentarian Edna W. 
Garza, TBLS-BCP.

Annual Meeting Committee:  Susan Davis, Melody Johnson, Megan Goor, Jay 
Williams, and Eugene Alcala (not pictured)

President’s Award—Rhonda Brashears, CP, TBLS-BCP
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President Goor graciously passing along the President’s gavel to President Hart Tucker
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2016–2017 EXCEPTIONAL PRO 
BONO SERVICE AWARD

By Julie Sherman, TBLS-BCP

Left to Right:  Shanna Mello, Pro Bono Chair; Katrina Lea; and Julie Sherman, TBLS-BCP.

It was my honor and privilege to 
present Katrina Lea with this year’s 
Exceptional Pro Bono Service 

Award. As most of you know, Katrina is 
a contract analyst/paralegal with BNSF 
Railway in Fort Worth. What you prob-
ably don’t know is that she is also the 
2017—President & Chair,  J.L. Turner 
Legal Assoc.—Paralegal Section; 2016 & 
2017—Ethics Chair, Fort Worth Paralegal 
Association; and the 2016—Annual 
Meeting Chair, SBOT-PD.

Katrina has held numerous board 
positions & chair positions with the 
SBOT-Paralegal Division, the Fort Worth 
Paralegal Association and the J.L. Turner 
Legal Association—Paralegal Section. 

Additionally, Katrina has been a long 
time Pro Bono volunteer with Legal Aid 
of Northwest Texas; State Bar of Texas—
Paralegal Division; Fort Worth Paralegal 
Association and Tarrant Volunteer 
Attorney Services (TVAS). 

I have had the opportunity to work 
with Katrina on numerous Pro Bono 
projects, Legal Aid of North West Texas’ 
Will Clinics, Tarrant Attorney Volunteer 
Services’ Family Law Clinics, Estate 
Planning Clinics and General Advice 
Clinics. Katrina uses her legal skills, 
knowledge, education and experience to 

help provide pro bono services to our 
community. Katrina is truly an Advocate 
for Justice. 

Over the past four years, Katrina has 
been a paralegal volunteer for numerous 
TVAS projects and events. In fact, she has 
missed only two events in those four years. 
Katrina is one of the “go to” people that is 
always willing to volunteer for a Pro Bono 
project and she does it with a smile on her 
face that reflects that she really and truly 

cares about people. 
Katrina was previously honored as The 

Tarrant County Bar Foundation’s 2015 
TVAS Volunteer Paralegal of the Year; The 
Fort Worth Paralegal Association’s 2013 
Paralegal of the Year, and the Fort Worth 
Paralegal Association’s 2009 and 2016 
Volunteer of the year. 

Please help me congratulate Katrina 
Lea, recipient of the 2016/2017 Exceptional 
Pro Bono Service Award. 

Do you want even more PD news?

The “Paralegal Pulse” is the PD’s monthly electronic newsletter. This is just another one of 
your PD membership benefits and is issued every month by the E-Newsletter Committee.  
Be sure to look for your e-newsletter e-mail around the 15th of every month for the latest 
PD updates and news!  

If you have a submission or question, please contact 
E-Newsletter Chair, Sheila Posey, TBLS-BCP, at

 e-newsletter@txpd.org.



AWARD OF EXCELLENCE

By Megan Goor, TBLS-BCP

Stephanie Sterling, TBLS-BCP, 
was awarded the PD’s award of 
highest honor, the 2017 Award 

of Excellence, by the Board of Directors. 
Stephanie was presented this award at 
the 2017 Annual Meeting held in June in 
Addison. President Megan Goor, TBLS-
BCP, expressed the deep appreciation 
and praises of the Board of Directors to 
Stephanie as she was presented her award. 
The Award of Excellence, by defi nition, 
is an award conferred by the Board of 
Directors of the Paralegal Division to rec-
ognize an individual who has made a sub-
stantial contribution to the paralegal pro-
fession. The award is given for outstanding 
merit and is not required to be conferred 
annually. Stephanie’s receipt of this award 
was due to diligent efforts accomplishing 
the herculean task of conforming all of 
the PD’s governing documents (Bylaws, 
Standing Rules, and Procedure Manual). 
Stephanie is the current President-Elect 
and served as Director of District 4, 
Parliamentarian, and several other roles 
before being elected as President-Elect in 
2016.

Stephanie is a Civil Litigation and 
Intellectual Property Paralegal with the 
law fi rm of DuBois, Bryant & Campbell, 
LLP in Austin.  Stephanie is a member of 
Capital Area Paralegal Association (CAPA) 
and has served CAPA in many board posi-
tions and committee roles over the years, 
including President in 2013–2014.  She has 
received CAPA’s Paralegal of the Year in 
2013, its Volunteer of the Year in 2011 for 
her outstanding volunteerism, and again 
in 2014 for her extraordinary commitment 
and dedication to CAPA.  Additionally, 
Stephanie was awarded with the NALA 
Affi liates Award in 2013 for her contribu-
tion and dedication to the advancement of 
the paralegal profession. 

Stephanie has demonstrated tremen-
dous dedication to the paralegal profes-
sion. Stephanie is also a member of the 
Texas Bar College, NALA—The Paralegal 
Association, and Women in E-Discovery. 

Award of Excellence—Stephanie Sterling, TBLS-BCP
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Past President Michele Boerder visiting the vendor hall. Keynote Speaker:  Peter Vogel

Morning speaker  —Rob Bogdanowicz President Goor, Rob Bogdanowicz, and Annual Meeting Chair Johnson

Jay Williams introducing morning speaker, Tom Mighell

Attendees enjoying morning CLE sessions



Thank you to the 2017 Annual Meeting Speakers and Sponsors!

Gold Sponsors

                      

Silver Sponsors

                          

Bronze Sponsors

        

Tote Bag Sponsor      Signage       AV Sponsor

                           

Left to Right—Tom Mighell, Peter Vogel and  Robert J. Bogdanowicz, III



2017–2018 EXECUTIVE COMMITTEE OFFICERS  
AND PD COORDINATOR

President
Mona Hart Tucker, ACP

Mona Hart 
Tucker, ACP, 
has been a 
member of 
the Paralegal 
Division since 
2001. She pre-
viously served 
as Secretary, 
Treasurer, 
and 

President-Elect of the Division, as well as 
Paralegal Division Director for District 14 
for the term years 2004–2006, 2006–2008, 
2012–2014, and 2014–2016. 

Mona works as a contract paralegal in 
the civil litigation field. She has previously 
worked in the oil & gas, real estate, and 
estate planning & probate areas of law.

Mona graduated cum laude from East 
Texas Baptist University in Marshall, and 
while there, also obtained her formal 
paralegal education in ETBU’s ABA-
accredited program. She earned her 
Certified Paralegal credentials from NALA 
in 2001, earned the Advanced Certification 
in Trial Practice in 2009, and Advanced 
Certification in Discovery in 2012. She was 
selected as a member of NALA’s inaugural 
LEAP class.

An avid amateur genealogist, Mona 
enjoys research and “dead ancestor 
hunts”. She currently serves as President 
of the Trevat Cemetery Association in 
Trinity County. Mona and her husband 
Lonnie live with their Chihuahua, Jamie, 
in Daingerfield.

President-Elect
Stephanie Sterling, TBLS-BCP
Stephanie has been a member of the 
Paralegal Division since 2003.  Until her 
election as President-Elect, she served the 
Division as District 4 Director from 2014–
2016 and 2016–2017, while also serving as 
Parliamentarian from 2015-2017. Stephanie 
is currently Chair to the Governing 
Documents Ad Hoc Committee, previous-
ly served as Marketing Chair on the TAPS 
2014 Planning Committee, and has served 

on several 
other commit-
tees in various 
roles with 
the Division. 
Additionally, 
Stephanie had 
the extreme 
honor to be 
appointed as a 
member of the 

State Bar’s Technology Program. 
Stephanie is a Civil Litigation and 

Intellectual Property Paralegal with the law 
firm of DuBois, Bryant & Campbell, LLP 
in Austin.  She became a Board Certified 
Paralegal in Civil Trial Law through the 
Texas Board of Legal Specialization in 2015.  
Stephanie earned her Associate of Applied 
Science Degree in Paralegal Studies with 
honors from Lamar University, an ABA 
accredited program, and went on to grad-
uate with a Bachelor’s of Science Degree 
in History with honors from West Texas 
A&M University.       

Stephanie is a member of Capital Area 
Paralegal Association (CAPA) and has 
served CAPA in many board positions and 
committee roles over the years, including 
President in 2013-2014.  She is also a mem-
ber of the Texas Bar College, NALA—The 
Paralegal Association, and Women in 
E-Discovery. 

Stephanie was honored to have 
received the Paralegal Division’s Award of 
Excellence in 2017 and CAPA’s Paralegal 
of the Year in 2013.  CAPA also awarded 
her with its Volunteer of the Year in 2011 
for her outstanding volunteerism, and 
then again in 2014 for her extraordinary 
commitment and dedication to CAPA.  
Additionally, Stephanie was awarded 
with the NALA Affiliates Award in 2013 
for her contribution and dedication to 
the advancement of the paralegal profes-
sion.   Stephanie has been a contributor to 
the Texas Paralegal Journal, the Paralegal 
Pulse, and CAPA’s The Brief.  Additionally, 
she has been a frequent speaker at various 
legal events and paralegal classes.     

Stephanie has been married to Clint 
for 25 years and they have 1 child, Caleb, 

who is 16.  She has served the local PTA 
organizations as Legislative Action Chair, 
Website Coordinator, and Homeroom 
Mom for numerous years as well as a 
teacher in AWANAs for several years.  In 
her free time, she enjoys spending time 
with family, traveling, reading, dancing, 
hiking, and participating in various obsta-
cle runs and 5Ks.

Treasurer
Javan Johnson, ACP, TBLS-BCP

Javan Johnson, 
ACP, is a 
Charter 
member of 
the Paralegal 
Division 
(PD) of the 
State Bar of 
Texas.  She 
has served PD 
for two terms 
as President 

(2000–2001; 2006–2007), a member of 
the Board of Directors, Membership 
Committee Chair, Public Relations 
Committee Chair, and the Texas 
Advanced Paralegal Seminar Planning 
Committee, as well as many other posi-
tions.  She is a co-author of the Paralegal 
Ethics Handbook. She has been honored 
with various awards including the high-
est Award of Excellence in 2004 and in 
2016 for her volunteer efforts with the 
PD.  Javan is a PD Ambassador and is a 
frequent speaker for PD on ethics and 
numerous civil trial and personal injury 
topics.  Javan is currently serving her 
second term as Director of District 14 
in Northeast Texas, and is serving as a 
Mentor for PD Proteges.  

Javan owns Professional Paralegal 
Services, a freelance paralegal service 
which opened in February 1999.   She spe-
cializes in civil trial and personal injury lit-
igation, and has more than 35 years para-
legal experience.  She received a Bachelor’s 
Degree in Business Administration and 
Education from Baylor University.   Javan 
obtained her Certified Paralegal (CP) 
from the National Association of Legal 
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Assistants in 1990, earned the NALA 
Advanced Civil Litigation specialty des-
ignation in 1993, and became certified in 
Civil Trial Law by the Texas Board of Legal 
Specialization in 1996.

Javan is devoted to the paralegal profes-
sion and educating paralegals all over the 
State.  She is also a charter member of the 
Northeast Texas Association of Paralegals, 
Inc. in Longview and has served that 
organization in numerous   since its incep-
tion.  Javan also assisted in organizing and 
starting the Paralegal Program at Kilgore 
College, and has taught in that program 
since 1988 and serves on the Advisory 
Board.  She has served on the Paralegal 
Civil Trial Commission for the Texas 
Board of Legal Specialization, and has 
served on the Board of Trustees for the 
Texas Center for Legal Ethics. 
Her husband, Brett, of more than 30 years 
has been very supportive of her career 
goals and volunteer efforts.  They have one 
son, Cameron.

Secretary
Mary Wintermote

Mary R. 
Wintermote is 
a senior litiga-
tion paralegal in 
the Fort Worth 
office of Cotten 
Schmidt & 
Abbott, LLP.   
Mary’s work 
as a paralegal 
spans more than 

23 years with an emphasis on civil trial 
practice in the areas of complex personal 
injury and wrongful death cases nation-
ally involving theories of premises liability, 
products liability, and medical malprac-
tice.  Mary also serves as liaison to several 
of the firm’s major clients and assists with 
technology training at the firm’s offices in 
Fort Worth and New Orleans.

Mary received her legal assis-
tant certificate from the University of 
Texas–Arlington in 1991 and previously 
attended Pennsylvania State University 
and Harrisburg (PA) Area Community 
College. Prior to that time, Mary worked 
in the public safety and emergency man-
agement fields in Pennsylvania eventually 
moving to Texas in 1989.

Mary is a member of the Fort Worth 
Paralegal Association and serves as its 
Litigation Specialty Section Chair.  She is 
also a member of the Dallas Area Paralegal 
Association.  Mary has been a member of 
the Paralegal Division of the State Bar of 
Texas since 2013 and served as Elections 
Sub-Chair, Volunteer Coordinator, and 
CLE Committee for District 3.

Mary and her husband, John, live 
in Arlington.  They have two children, 
Katharine and Joseph, 4 rescue dogs and 
1 cat.  She has a variety of hobbies and 
enjoys volunteering for several civic and 
charitable organizations in the Dallas/Fort 
Worth area.

Parliamentarian
Edna Garza, TBLS-BCP

Edna will be 
serving as the 
new Director 
for District 15 
for 2015–2017.  
She has been 
a member of 
the Paralegal 
Division since 
2011 and has 
served as the 
District 15 

Continuing Legal Education Committee 
Sub-Chair from 2011–present.

Edna has 25 years of experience as 
a Paralegal. She obtained her Paralegal 
certificate from South Texas Vo-Tech in 
McAllen, Texas in 1991.  She was also a 
Paralegal Instructor for 4 years at South 
Texas Vo-Tech from 1994– 1998.  Edna 
obtained her board certification in Civil 
Trial Law by the Texas Board of Legal 
Specialization in December 2014.  For 
most of her paralegal career, Edna has 
worked in litigation, specializing in per-
sonal injury/wrongful death cases, com-
mercial/lender-liability, employment and 
collection work.

Edna will be completing her Associate 
of Arts Degree (Interdisciplinary Studies) 
in December 2015.  She will be seeking 
a Bachelor of Applied Science Degree in 
Organizational Leadership at South Texas 
College in McAllen, Texas.  Edna obtained 
her real estate license in May 2012 and is a 
part-time Realtor.  Since her licensure, she 
has acquired experience in REO (bank-

owned) properties and works with buyers 
and sellers in residential sale transac-
tions.  She also has experience working in 
property management.  Edna is a mem-
ber in the Greater McAllen Association 
of Realtors; The Texas Association of 
Realtors; and the National Association of 
Realtors.  

PD Coordinator
Rhonda Brashears, CP, TBLS-BCP

Rhonda 
Brashears is a 
paralegal with 
the firm of 
Underwood 
Law Firm, 
P.C., Amarillo, 
Texas, and has 
been in the 
legal profes-
sion for over 
30 years. She 

specializes in personal injury and civil trial 
defense law. She received her B.G.S. from 
West Texas A&M University in 1998, her 
Certified Paralegal designation from the 
National Association of Legal Assistants in 
1996, and was board certified by the Texas 
Board of Legal Specialization in Personal 
Injury Trial Law in 1998.

Rhonda began her position as Paralegal 
Division Coordinator in January of 2016.  
Rhonda proudly serves the Paralegal 
Division in this exciting new role, but 
she is not new to the Parlegal Division.  
She has been a member of the Paralegal 
Division since 1990. She also currently 
serves the Division as an Ambassador.  
In the past she has served as Director of 
District 7, 1996 until 2001, Secretary, 1999 
to 2001, President Elect in 2001 and 2007, 
and President of the Division in 2002 and 
2008.  She has also previously served as 
Chair of the On-Line CLE Committee, 
the TAPS Planning Committee, the 
Publications Committee and as Editor of 
the Texas Paralegal Journal.  Rhonda is a 
member of the Texas Panhandle Paralegal 
Association, where she has served as 
President, President-Elect, Treasurer and 
NALA Liaison.
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PARALEGAL DIVISION BOARD OF DIRECTORS
2017–2018

The 2017–2018 Paralegal Board of Directors was installed at the Annual Meeting in Addison on Friday, June 23, 2017.

This year’s board members are: 
Executive Committee  

President—Mona Hart Tucker, ACP; President-Elect—Stephanie Sterling, TBLS-BCP; Treasurer—Javan Johnson, ACP, TBLS-BCP;
Parliamentarian—Edna Garza, TBLS-BCP; and Secretary—Mary Wintermote

 
DISTRICT DIRECTORS
District 1 Sherylyne Hollinger, RP, 

PHP
Houston

District  2 Jay Williams, TBLS-BCP
Dallas

District 3   Mary Wintermote
Fort Worth

District  4 Pamela M. Etie, ACP
Austin

District 5 Susi Boss
San Antonio

District  6 Michael Akins
Lubbock

District 7 Sharla Fowler, CP
Amarillo

District  8 Vacant

District 10 Jennifer Barnes, CP
Conroe

District 11 Sandra Seutter
Midland

District 12 Michelle Beecher
Denton

District 14 Javan Johnson, ACP, 
TBLS-BCP
Longview

District 15 Edna W. Garza, TBLS-BCP
McAllen

District 16 Rebecca Lopez
El Paso
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A special “Thank You” to Immediate Past 
President Megan Goor, TBLS-BCP and the 

Outgoing Directors for their tireless work 
in representing the Paralegal Division: 

District 1—Jennifer Evans, CP, Houston

District 5 –  Susan Wilen, RN,  
San Antonio

District 7—Shandi Howard, CP, Lubbock

District 11—Jan McDaniel, CP, Midland
 

PARALEGAL DIVISION
COMMITTEES AND LIAISONS ROSTER

2017–2018

STANDING COMMITTEES

Committee Chair Board Advisor

Annual Meeting Alice Lineberry, PLS, CP Pam Etie, ACP, D-4

Continuing Education Jennifer Evans, CP 
(District)
Shannon Shaw, CP and 
Kara O’Shaugnessy 
(Online)

Jay Williams, TBLS-BCP, 
D-2

Elections Martha Ramirez, CP Michelle Beecher, D-12

Membership Francesca Romans, ACP Pam Etie, ACP, D-4

Professional Development Donna Lynn Waldon Mary Wintermote, D-3

Professional Ethics Ellen Lockwood, ACP, 
RP

Jennifer Barnes, CP, D-10

Public Relations Erica Anderson, ACP

Cynthia Minchillo, RP, 
Blog Coordinator

Rebecca Lopez, D-16

Publications Megan Goor, TBLS-BCP Edna Garza, TBLS-BCP, 
D-15

Procedures Manual Stephanie Sterling, 
TBLS-BCP

Stephanie Sterling, TBLS-
BCP

District 5—Susan Wilen, RN, and District 7—Shandi Howard, CP
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AD HOC COMMITTEES

Committee Chair Board Advisor

Ambassador Debbie McBride Sandra Seutter, D-11

E-Group Policy Kimberly McDonald, 
TBLS-BCP

Sharla Fowler, CP, D-7

E-Newsletter Sheila Posey, TBLS-BCP Javan Johnson, ACP, TBLS-
BCP, D-14

Membership Renewal Spot 
Audit

Deb Pointer Mary Wintermote, D-3

Paralegal Ethics Handbook Ellen Lockwood, ACP, RP Jennifer Barnes, CP, D-10

Pro Bono Shanna Mello Edna Garza, TBLS-BCP D-15

TAPS Megan Goor, TBLS-BCP Mona Tucker, ACP

Texas Bar College 
Membership Application 
Review

Jena Parker, CP Susi Boss, D-5

Sustaining Member / Vendor 
Liaison

Susan Davis, TBLS-BCP Michelle Beecher, D-12

TBLS Helpful Hints Guide Javan Johnson, ACP, 
TBLS-BCP

Javan Johnson, ACP, TBLS-
BCP, D-14

Website Development Michelle Beecher Michelle Beecher, D-12

Mentor Program Deb Pointer Sherie Hollinger, RP, PHP, 
D-1

Governing Documents Stephanie Sterling, TBLS-
BCP 

Stephanie Sterling, TBLS-
BCP, D-4

LIAISONS
Organization Liaison

American Alliance of Paralegals (AAPI) Jennifer Barnes, CP, D-10

American Association for Paralegal Education 
(AAfPE)

Sharla Fowler, CP, D-7

American Association of Legal Nurse Consultants 
(AALNC)

Sherie Hollinger, RP, PHP, D-1

American Bar Association (ABA) Rebecca Lopez, D-16

Office of Court Administration Michelle Beecher, D-12

National Association of Legal Assistants (NALA) Susi Boss, D-5

National Federation of Paralegal Associations 
(NFPA)

Jay Williams, TBLS-BCP, D-2

Texas Alliance of Paralegal Associations (TAPA) Mona Tucker, ACP, President

Texas Association of Legal Professionals (TALP/
NALS)

Sandra Seutter, D-11

Texas Board of Legal Specialization (TBLS) Edna Garza, TBLS-BCP, D-15

Texas Lawyers for Texas Veterans (TLTV) Javan Johnson, ACP, TBLS-BCP, 
D-14

Texas Young Lawyers Association (TYLA) Mary Wintermote, D-3
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PARALEGAL DAY EVENTS
In 2009, the Texas State Senate adopted Proclamation No. 1144, recognizing October 23rd as Texas Paralegal Day, to honor the paralegal 
community. Join your fellow members by celebrating Texas Paralegal Day at your district event:

District Date / Time 

1  October 23   5:30–7:30pm 

2  October 23  TBD 

3  October 18   noon–1:30pm 

4  October 27  6:00–8:00pm 

noon–1:00 

TBD 

TBD 

 6–8pm  

5  October 27 

7  TBD 

10   October 20 or 23 

11  TBD 

12 

14 

15  Oct. 26 

16  Oct. 19   8:30 a.m.–1:00 p.m. 

Location & Plans

Birraporetti’s in Downtown Houston 
Social meet and greet with Houston Metropolitan Paralegal Association

Luncheon 
With Dallas Area Paralegal Association, North Texas Paralegal Association, 
and J.L. Turner Legal Association

Pappadeaux, 2708 West Freeway, Fort Worth 
CLE and Luncheon with Fort Worth Paralegal Association

TBD 
Reception with keynote speaker with Capital Area Paralegal Association

Norris Conference Center, San Antonio 
14th Annual San Antonio Paralegal Day Celebration, “The Legal Profession: 
Where are We Now & Where will We be in 10 Years?”—speaker, G. Thomas 
Vick, Jr. with San Antonio Paralegal Association

TBD 

TBD 
Happy Hour 

Local Country Club 
Appreciation luncheon with a local judge as keynote speaker with local bar 
association and local paralegal association in Midland

TBD 
With Denton County Paralegal Association

Reception 

Arturo’s Mexican Restaurant, Weslaco 
3rd Annual Paralegal Day/Member Appreciation Social 

Auditorium located at the Stanton Building.
Half-day seminar and luncheon to celebrate Texas Paralegal Day with the El 
Paso Paralegal Association





 E-Group Forum – join the members only forum with hot topics, forms, ethics, and general questions 
posted and answered by paralegals. Be sure to sign up for this after receiving your membership card!

 Texas Board of Specialization (TBLS) Helpful Hints Guide - be ahead of the rest. If you are planning 
to take a TBLS Specialty Exam, then we have this Helpful Hints Guide that is packed with information 
to help you through every step of the exam process, from application to sitting for the actual exam.  It has 

 www.MyTexasBar.com 
free access to case law and many other perks.

 Free legal research through Casemaker and Fastcase.
 Membership Directory and Listing in Texas Legal Directory (Blue Book) 

district, reconnect with previous colleagues, or
meet new friends.

 Job Bank 
 Mentor Program  here. 
 Statewide CLE Depository – event notices of upcoming CLE and related events hosted by PD and State 

Bar of Texas.
 Texas Advanced Paralegal Seminar – 3 days of CLE Hours for one low great price and available every 

year!
 Track attendance to MCLE approved CLE Online – log in and view SBOT MCLE-attended CLE and 

submit other CLE attendance before you forget!
 Pro Bono Events 
 Subscriptions to the Texas Paralegal Journal and Texas Bar Journal – keep up to date with current 

event issues, tips and tricks as technology evolves, and what others are doing in similar situations.
 Discounts – available from Hewlett-Packard, Blue Apron, and much more!  For a complete list, go to 

www.texasbar.com OR View HERE.
  – health, life, and dental insurance programs and credit 

unions, and more.
 PD Travels to Destinations Unknown – take a trip of a lifetime with colleagues. Recent expeditions 

include Ireland, Italy, and France.
 Professional Recognition and Growth – hold yourself to a higher standard with the communication and 

promotion of professional conduct and responsibility. Your attorneys will notice the change.
 Networking – communication and promotion of professional conduct and responsibility. State networking 

through involvement with statewide committees. Be proactive in the promotion and direction of the parale-
gal profession!

 www.txpd.org – the one-stop shop for your needs. Find all of this information, plus so much more, includ-
ing helpful tips and links to vendors, blogs, and other sources of information.
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State Bar of Texas 

Paralegal Division

All of the PD mentors are Division members who have at least 7 years’ experience 
working as a paralegal. Many of our mentors are also Division leaders and liaisons. 

Mentors are located across the state and work in many areas of law.   

Protégés may be matched with a mentor who is not geographically close by;  
meetings may be held electronically based on the mentor and protégé’s preferences.
The mentoring program is a  available to Paralegal Division members.  
Join the PD today and let us match you with a mentor in your area of legal interest!

Visit  to learn more about membership and the Mentor/Protégé program.

 

 

The Paralegal Division offers a mentor program to help you get started! 

Student members 
Active and Associate members  
with less than 3 years’ work  
experience as a paralegal
PD members changing the area  
of law on which they focus

The mentor / protégé relationship can be very rewarding, with 

PD Mentor / Protégé Program

Participants receive direction and support on topics such as ethics, career advancement, 
and professionalism. Protégés also have access to valuable networking opportunities 

with other paralegals and the legal community through their mentor, as well as at 
state-wide and district Paralegal Division events.



PARALEGALS
Texas Bar College

Associate Membership

PRIDE & PROFESSIONALISM

Please visit the Texas Bar College website for more information 
on becoming a Paralegal Associate Member:

https://texasbarcollege.com/merchandise/membership

Please visit the Texas Bar College website for more information 
on becoming a Paralegal Associate Member:

https://texasbarcollege.com/merchandise/membership


